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1. About This Guide 
 

This user’s guide describes how to use the most popular features of CapdetWorks, the wastewater 

treatment system preliminary cost-estimating tool from Hydromantis Inc. 

This section provides an overview of the organization and conventions used in the guide. For a 

description of the underlying technical content, the reader is referred to the “EPA Reference” 

(available in .pdf format) and the “Help Contents” included with the software. These are available 

from the Help menu of the software. 

1.1 Contents 
This guide provides an overview of CapdetWorks and details several popular features. The guide is 

organized in seven sections: 

Chapter 1: Introducing CapdetWorks – This section introduces CapdetWorks and outlines 

background on its history. 

Chapter 2: Getting Started – This section introduces the user interface and gives an overview of the 

main features of the program. 

Chapter 3: The Design Details Window – This section focuses on the “Design Details” window and 

gives an overview of how one examines a design calculated by CapdetWorks.  

Chapter 4: Tutorials – The section is subdivided into six tutorials that are organized as step-by-step 

guides to the features and use of CapdetWorks. 

Chapter 5: How To… – This section is a guide to the use of CapdetWorks features a series of step-

wise procedures. 

Chapter 6: Process Reference – This section is consistent with the on-line help system and lists the 

unit process parameters, typical ranges for these parameters (where applicable), and the 

CapdetWorks default values.  

1.2 Assumption 
This guide assumes that you are familiar with the version of Windows you are using. If you are not 

familiar with the Windows’ terms such as “click”, “drag”, “menu”, or “check box”, refer to your 

Windows’ documentation.  

1.3 Using the On-line Help 
CapdetWorks contains an on-line help system that provides help on the process units in the 

program. Searching facilities are available for finding specific treatment options. The online help is 

accessible from the Help menu through “Help Contents” item. 
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2.  CapdetWorks 
 

Accurate and rapid preliminary design and cost estimating for wastewater treatment plant 

construction projects is a worldwide priority. Spreadsheet models are commonly used to provide 

planning or design level cost estimates, but these models are relatively inflexible and time 

consuming to modify.  

CapdetWorks has been designed to give public and private planners, design consultants and 

construction companies the ability to quickly evaluate design alternatives. The software designs 

each unit process in a given process layout based on the influent characteristics and then estimates 

the cost of the design. This two-step approach gives the user the option to review the produced 

design and modify the design by using the design override features in the program, if necessary. 

Typical design defaults have been used for each unit process to produce acceptable calculated 

designs and make the software easier to use for planners that require a planning-level cost 

estimates of a new facility or an upgrade to an existing facility.  

2.1  About CAPDET 
The CAPDET model was developed by the U.S. Army Corps of Engineers for the U.S. EPA to facilitate 

the evaluation of wastewater treatment alternatives based on life cycle costs and the degree of 

treatment provided. 

The original version of CAPDET, developed in 1973, utilized accepted process design techniques 

followed by the development of costs based on cost curves. This parametric cost estimating 

approach limited the overall utility of the model in that it was difficult to update, did not adequately 

reflect regional cost differences and could not accommodate site-specific design requirements. To 

improve the accuracy and usefulness of CAPDET, a revised cost estimating procedure using both 

parametric and unit cost estimating techniques was developed.  

Model Limitations  

Although the revisions to the CAPDET model have greatly expanded the capabilities and improved 

the accuracy of planning-level design and cost estimating procedures, the user is cautioned about 

the limitations of generalized modeling approaches. Necessity dictates that the design and cost 

algorithms developed for any generalized estimating procedure must include simplifying 

assumptions. Items such as engineering judgment, equipment design limitations, site limitations, 

and regulatory reliability and maintainability standards all enter into formulation of the algorithms. 

The philosophy of CAPDET is to approach each of these problems in a sound fashion. During 

development of the CAPDET procedures, various design standards were reviewed and an attempt 

was made, where possible, to develop generalized design standards based on these requirements.  
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The CAPDET methodology uses two separate cost estimating techniques. The cost of construction 

within each unit process is computed using unit-costing techniques. The problems associated with 

engineering judgment and equipment design limitations were addressed through the use of a 

recognized engineering firm for algorithm development and consultation with a variety of 

equipment manufacturers to determine equipment limitations. Additional site-specific costs are 

addressed through use of statistically generated cost curves based on average costs.  

2.2  CapdetWorks Scope 
A distinction should be made between CAPDET, the model, and CapdetWorks, the software 

package. Although based on the CAPDET model, the major emphasis with CapdetWorks has been 

the development of accurate planning-level cost estimates for a large number of unit processes in 

an easy-to-use format. Further, CapdetWorks is an enhancement of the CAPDET model as 

Hydromantis has added a number of unit processes (i.e. SBRs, UV disinfection…) not originally 

included in the CAPDET model. These design algorithms are copyrighted by Hydromantis and any 

reference to these algorithms should be properly referenced. 

CapdetWorks provides cost estimates for user input alternatives, but CapdetWorks is not a 

mathematical optimization tool; therefore, will not provide the "mathematically optimal" solution to 

an infinite universe of alternatives. Rather, CapdetWorks approaches the facility planning process in 

the same fashion as would an engineer preparing alternative designs and cost estimates.  

CapdetWorks is not a process simulation tool. Hydromantis, Inc. has developed other process 

simulation software (GPS-X™) to predict dynamic process behavior and treatment plant 

performance. The user is encouraged to apply this more advanced tool in situations where process 

optimization or more accurate prediction of water quality is desired. 

CapdetWorks has been designed primarily as a cost-estimating tool based on the CAPDET model. 

Process design and effluent quality predictions are of secondary importance to the overall cost 

estimating accuracy desired of the model. Thus, any review of the assumptions and simplifications 

should be conducted primarily from a cost generation viewpoint. The generation of effluent quality 

predictions is limited and, in many cases, requires a user input percentage removal factor.  
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3. Getting Started 
 

To start CapdetWorks, double click on the CapdetWorks shortcut on the desktop. The CapdetWorks 

shortcut icon is created automatically after first installation of the program. Note that CapdetWorks 

will start in demonstration mode unless an appropriate hard-lock protection device is plugged into 

your computer system. The software will also run in demonstration mode, if you do not have a valid 

license key code. 

3.1  User Interface 
When CapdetWorks is first launched, the user will see the Main Window.  

The Main Window consists of the following key components: 

• Title Bar 

• Menu Bar 

• Toolbar 

• Costing Summary Bar 

• Process Tool Bar 

• Drawing Board with Layout Tab(s) 

• Output Panel 
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Like other Windows programs, the CapdetWorks window can be maximized, minimized or manually 

resized using the Windows border.  

Title Bar 

In addition to telling you the name of the program (i.e. CapdetWorks) and the location and file name 

of the file you are working on, the Title Bar can be used to move the position of the Main Window 

on the screen. 

 Menu Bar 

The Menu Bar contains the following drop-down menus: 

 

Detailed descriptions of the commands found in these menus appear throughout this manual. 

Toolbar 

The Toolbar contains a number of shortcuts for some of the more commonly used menu items, as 

well as the selection box for the equipment costing database 

 

Costing Summary Bar 

Once a layout has been costed, the Costing Summary Bar shows the “Present Worth” cost estimate 

of the current layout and the breakdown of that estimate into its component parts. If a layout hasn’t 

been costed, then the values are displayed as “NA” for “Not Available”. 

 



CapdetWorks V4.0  2018 

 

3-15 | Hydromantis Environmental Software Solutions, Inc. 

 
 

The “Toolbars” item in the “View” menu may be used to hide/unhide the Costing Summary Bar 

from the interface. The Toolbars item also provide access to hide/unhide Process Toolbar and 

output Table Toolbars.  

Process Tool Bar 

All of the unit processes in the Process Toolbar are classified into several groups organized as 

process tabs. Inside each process tab, unit processes of similar type or functionality are available. 

User can click on each process tab to accesses the different unit process groups.  

 

Drawing Board and Layout Tabs 

The Drawing Board is where the user “draws” a schematic of the plant layout and process flow. 

Multiple layouts can be compared in CapdetWorks by “drawing” different layouts on different tabs. 
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Output Table Tab 

The Output Table tab is used to visualize the model outputs. The Output Table tab can display the 

cost estimates for different unit processes, the water quality parameters for each process or 

variation of a selected water quality indicator across all the unit processes in the layout.  

3.2  Preferences 
There are several “global” setup options in CapdetWorks that can be used to customize the display 

of variables. These “global” options are accessed through the View drop-down menu and selecting 

the Preferences item. In the Preferences window, user can select the model units for inputs and 

outputs, the number of significant figures used, currency used, and the default layout location. 

Variables can be displayed with U.S. Units, SI Units, or the default setting of Mixed Units. 

CapdetWorks includes a unit conversion algorithm that automatically corrects any displayed value if 

the units are changed.  

 

In addition to being able to change the units globally, CapdetWorks allows the user to change the 

units of each input model variable if necessary. Right-clicking directly on the units of any variable on 

the process input form will bring up a list of alternatives. The user can then select the preferred 

units from the list. 

Distribute “other construction costs” allows users to distribute the estimated other direct and 

indirect costs to individual unit processes in proportion to the estimated construction cost of the 

unit process. By default, the “other construction costs” are estimated separately and not distributed 

to individual unit processes.  
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As there are a significant number of parameters in CapdetWorks, the “Highlight Modified Values in 

Input Forms” option can be used to signal if a value and/or unit setting has been changed from the 

default. When checked, any value or unit changed from the default setting will be colored blue to 

signal that a change has occurred. Placing the cursor on the modified value will show the default 

value of the parameter. To revert back all the changed values to default values, the “revert” button 

available at the left corner of the form can be used. 
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3.3  Drawing a Layout 
The drawing board forms the basis for the design of the system flow scheme. Unit process objects 

are dragged from the Process Tool Bar to the drawing board with the mouse. The objects are linked 

via virtual pipes to signal the flow of the liquid and/or solid streams (see the “How To…” chapter of 

this manual for more detailed information on drawing a flow scheme and connecting objects). 

 

Drawing Board Display Options 

Since the drawing board can become quite crowded if a complex treatment plant is being costed, 

there are various visual options that can be turned on or off depending on the users’ desires. These 

options are accessed through the “View” menu in the Menu Bar, or by right-clicking on an empty 

area of the drawing board. The options are to turn on or off the grid, process labels, or connection 

points. 

Each unit process depicted on the drawing board has an associated process label. To change the 

label for a particular object, right-click on the object and select “Edit Label/Image” from the object’s 

edit menu. 

 

 

3.4  Unit Process Parameters 
Each unit process has a number of associated parameters that have an impact on the design and 

cost of the process. As it is not the purpose of this guide to address all the unit processes in 
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CapdetWorks, a simplified discussion is used to illustrate the parameter structure. The user is 

referred to the on-line help and Technical Reference for the meaning and use of specific parameters. 

In general, the unit process parameters, which can be found in the unit process dialog (right click on 

the unit and select “Edit Parameters”), can be subdivided into four categories [note that not all the 

unit processes have all categories]: 

• Process Parameters 

• Design Override 

• Equipment 

• Replacement Schedule 
 

Process Parameters 

The process parameters relate to process-related criteria. Parameters in this group might be 

overflow rates and percent solids removal for a clarifier, or solids concentration and oxygen transfer 

efficiency for an aeration basin. These parameters may be located on one or more tabs in the 

process dialog depending on the type and grouping of the data entry fields. 

 

CapdetWorks uses the process parameters to design the applicable system; however, the design 

created by CapdetWorks can be modified if a different design is required. This is accomplished using 

the “Design Override” tab.  

 

Design Override 

CapdetWorks performs a preliminary design and then costs that design. The “Design Override” tab 

(which is available for many of the processes in CapdetWorks) gives the user the ability to override 

or fine-tune, a suggested design. This is best accomplished by allowing CapdetWorks to first design 
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the process, which will fill in the design criteria on the “Design Override” tab. By default and prior to 

design, the entry fields on this form will be grayed-out and will be zero. Following the design of the 

unit process, these fields will still be grayed-out, but will contain the CapdetWorks suggested design 

data. This gives the user the possibility to view what CapdetWorks designed for the process. After 

reviewing the design, the user can then adjust any items that should be overridden. 

If the design is unsatisfactory, the user can check the “Override Design” checkbox. This will activate 

the entry fields and give the user access to the design criteria. If the user changes an entry on this 

tab, the layout must be re-costed. The new design will be constrained by all of these entries 

irrespective of how many the user changed manually. To revert back to the original default design, 

the user need only uncheck the “Override Design” checkbox and re-cost the layout. 

    

Equipment Parameters 

A similar procedure can be followed for the process equipment costs. To override the cost 

estimates, the user should check the “Override Database Costs” checkbox and gain access to the 

cost entry fields. 

Each equipment entry field has an associated tooltip that can be used to access further information 

about the calculation of a particular cost estimate. The tooltip is displayed when the cursor is 

positioned over the entry field of interest. 
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Replacement Schedule 

The costing algorithms take into consideration the replacement period for mechanical and structural 

parts of each unit process. These life-span estimates can be viewed or changed by clicking the 

“Replacement” tab in the unit process dialog. 
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3.5  Cost Data 

Note: To effectively use CapdetWorks, the unit costs, cost indices, site-
specific costs, and equipment costs should be customized before using 
the cost estimates produced by the program.  

Unit Costs 

CapdetWorks includes a number of default construction-related unit cost estimates, and like the 

previously discussed costing parameters, the user can override these default estimates, if necessary. 

The unit costs dialog is accessed through the “Cost Data” menu by selecting “Unit Costs” or by 

clicking on the “Unit Costs” shortcut button on the Toolbar. 

 

This dialog includes a series of tabs where user can also input Labor Rates, Chemical Costs, Region 

Specific Costs, Financial and Other Costs like profits, engineering fee and contingency etc… 

Cost Indices 

To account for changing costs over time in the costing algorithms, CapdetWorks uses a number of 

equipment-related cost indices to adjust costs to the present. The cost indices dialog is accessed 

through the “Cost Data” menu by selecting “Cost Indices”. 

This dialog is used to update the applicable cost indices to the current values as published on a 

regular basis in several popular trade publications [Marshall and Swift, Engineering News Record, 

Chemical Engineering magazine].  
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One of the equipment databases is based on Hydromantis Indices and these indices can be updated 

from the Hydromantis website at the time of costing the layout.  

 

Overrides for Site-Specific Costs 

Specific sites may require special consideration with respect to construction-related issues. To allow 

the user the ability to account for these charges, CapdetWorks includes the option to enter special 

site costs into the costing algorithm. The Additional Site-Specific Costs dialog is accessed by selecting 

“Override for Site-Specific Costs” from the “Cost Data” menu. 
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If the user wishes to override the estimates that CapdetWorks calculates, then they can select the 

checkbox beside the desired value and enter their own specified value, or enter zero to not include 

the value at all. 

Equipment Costs 

CapdetWorks makes use of a selected equipment database to cost equipment in a particular design. 

The database to be used for a particular layout can be selected using the “Equipment Costing 

Database” drop-down box on the toolbar. 

 

By default, CapdetWorks uses the "Hydromantis 2014, (USA Avg.)” database for costing all types of 

treatment equipment, but it also is possible to use a Standard 2014, Sept 2007, July 2000, 1977 or a 

user-defined database if preferred [note that all the cost estimates in the database are adjusted to 

the present via an indexing system]. The Equipment Costs database dialog is accessed through the 

“Cost Data” menu by selecting “Equipment Cost Database”. 

Using this editable database, users can adjust costs, the index to be used and the value of the index 

at the time that the cost was found. (See the “How To…” chapter of this manual for more 

information about how to create your own database.)  
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3.6  Cost Analysis 
Once the flow schematic is drawn and the appropriate unit process and construction costs have 

been entered, a cost estimate for the layout can be determined by selecting the “Estimate Cost of 

Current Layout” menu item in the “Model” drop-down menu or by clicking on the shortcut button 

on the Toolbar. A summary of the cost estimate for the layout will be displayed on the Costing 

Summary Bar.  

A more detailed breakdown of the estimated costs can be viewed by selecting the “View Cost 

Details of Current Layout” menu item in the “Model” drop-down menu or by clicking on the 

shortcut button on the Toolbar. These procedures bring up the cost details, which include a cost 

breakdown, design information and estimated wastewater quality data for each unit process. 

 

 

3.7  Comparison of Costs 
If more than one layout has been drawn, it is possible to easily compare the costs of each layout by 

selecting “View Cost Details of All Layouts” from the “Model” drop-down menu. This produces 

dialog window with a table at the top with the layouts in the current file and a breakdown of the 

estimated costs for each layout. Below that is a tabbed pane with the details of the cost estimate for 

each layout. 
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It is possible to create a printable chart of the estimated costs by clicking on the “Chart” button in 

this summary window and choosing the appropriate variable from the drop-down menu displayed in 

the chart margin. 
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3.8  Sensitivity Analysis 
The ability to run sensitivity analyses with the designed layouts is a very useful feature of the 

program. CapdetWorks gives the user the ability to analyze the estimated cost of a particular 

configuration over a user-specified variable range. For instance, an estimate of the total cost of a 

configuration can be analyzed as a function of the influent average flow rate.  

Alternatively, a sensitivity analysis might provide valuable information about design decisions in the 

case where some variables are not known with certainty. Take for example two alternatives: one 

that is insensitive to an unknown variable; and, one that is very sensitive to the magnitude of that 

variable. In this case the designer may wish to know how important an accurate measure of that 

parameter is, and may choose the “safer” alternative if an accurate measure is not available. 

The Sensitivity Analysis window is accessed by choosing “Sensitivity Analysis” from the “Analysis” 

menu on the Menu Bar. The resulting dialog window gives the user the ability to choose the process 

of interest, the parameter of interest, and the range over which the cost analyses should be done. 

The analysis calculates the parameter impact on the total cost of the plant and, where applicable, 

the cost of the specified unit process. 
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4. Design Details Window 
4.1  Introduction 

CapdetWorks is a powerful tool for the design and preliminary costing of wastewater treatment 

facilities, and the details of the calculated design are a crucial output of the application. The details 

of the calculated design are found in the “Details for…” window (henceforth referred to as the 

Details window). As this window is the basis for understanding the calculated design, this chapter is 

present to explain the important features of this window and its subsections. 

The Details window is accessed by choosing “View Cost Details of Current Layout” from the 

“Model” menu. The window has two sections: one, which lists the unit processes in the layout; and 

one, which lists the particulars of the individual unit processes. The particulars section is further 

divided into two subsections: “Design Information” and “Wastewater Quality”. 

 

4.2  Unit Processes Table 
The “Unit Processes Table” is a selectable table of all the unit processes and a summary of their 

costs for the applicable layout (i.e. the layout named in blue type above the list box) plus one or 

more extra processes depending on the layout. These extra processes may include a blower system 

and/or a chemical addition process. The list will include an “Other Costs” item, which contains the 

cost estimates for items not directly applicable to a single unit process, but rather to the project as a 

whole (e.g. land requirements, profit, professional fees and additional site specific costs). 

Design 

Information 

Subsection 

Wastewater 

Quality 

Subsection 

Unit Process 
List 

Particulars 

of the 

Unit Process Design 
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4.3  Design Information Table 
The section below the “Unit Processes Table” contains information that is directly applicable to the 

selected unit process. The “Design Information Table” contains three subsections. 

The first subsection, “Design Information”, lists the parameters used for the design and the 

calculated output from the design algorithms.  

 

The second subsection, “Quantities Required”, lists the materials required to build the process (i.e. 

How much concrete, energy, earthwork…). 

 

The last subsection, “General Notes”, shows additional information of the costs for the process. 

 

Note: Some unit processes will have some or all of these subsections 
repeated one or more times. This is to separate the component parts of the 
unit process design. For example, the pump design in a Complete Mix 
Activated Sludge unit process is separated from the tank design. Other unit 
processes make similar distinctions and in each case, the design information 
is organized into one or more of the three subsections as required. 

 

Aeration and chemical addition (lime, alum and iron) are special cases that are handled slightly 

differently. For layouts that require air, a blower system is automatically designed and listed as a 

separate unit process. This is because one blower system is designed for the whole system. That is, 

the designed blower system may provide air to one or more unit processes in the layout and it is 

designed to be large enough to do so. However, it is important to note the way that the costs are 

assigned. Note that the Blower System parameters can be accessed through the “Model” menu in 

the main menu bar. 
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In the case of aeration, the “Blower System” costs do not include energy. Rather than assigning 

those costs to the blowers, the aeration energy costs are assigned to the unit processes that require 

the air. In this way CapdetWorks provides a clearer picture of the costs of those processes. 

 

A similar approach was followed for chemical addition as chemicals may be added in one or more 

unit processes in the same layout.  The chemical costs are assigned to the unit process using the 

chemicals and the chemical feed system itself does not report any chemical costs. 

 

Chemical costs are associated with the unit process using the chemicals. 

 

Only construction costs are associated with the “Blower System”.  The energy costs for the aeration 

are applied to the unit process that requires the air. 

4.4  Wastewater Quality Table 
The “Wastewater Quality” subsection of the “Particulars” section lists the wastewater quality into 

and out of each unit process. That is, the column title “Influent” refers to the influent to the unit 

process and “Effluent” refers to the effluent from the unit process. These titles should not be 

confused with the influent and effluent wastewater quality for the system as a whole. The sludge 

property in the unit process and its units are also listed. 
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5. Tutorials 
5.1  Introduction 

CapdetWorks has many unique features that make it a powerful tool for the design and preliminary 

costing of wastewater treatment facilities. As you become acquainted with CapdetWorks, you will 

quickly see ways it can be used to make your engineering tasks more productive. 

This Tutorial chapter is intended for first-time users of CapdetWorks and is meant to introduce the 

user to many of the features and procedures used in CapdetWorks. To best understand the material 

in these tutorials, you should have a background in the fundamentals of wastewater treatment 

including the unit processes and typical wastewater treatment facility design criteria.  

This chapter is divided into several tutorials that cover various aspects and features of CapdetWorks. 

The following is a brief introduction to the material covered in each tutorial. 

Tutorial 1: Basic Design and Costing 

Tutorial 2: Customizing the Costing Parameters 

Tutorial 3: Overriding the CapdetWorks Design 

Tutorial 4: Performing a Sensitivity Analysis 

Tutorial 5: Comparing Alternative Designs 

 

As with the rest of this guide, it is assumed that you have a working knowledge of your computer’s 

operating system and that CapdetWorks is properly installed on your computer.  
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5.2  Tutorial 1 
 

Basic Design and Costing 

This tutorial covers the following topics: 

1. Using the drawing board to draw a process flow schematic 
2. Adjusting the influent wastewater characteristics and design criteria 
3. Costing a design and reviewing the detailed breakdown of those costs 
 

Building a Simple Layout 

After starting CapdetWorks, display the drawing board grid (if not already displayed). 

1. Access the View Menu by left-clicking on “View” on the Menu Bar.  
2. Choose “Display Grid”. The drawing board grid will be displayed on the active 

sheet. 

 
 

Alternatively: 

1. Access the drawing board edit menu by right-clicking on white space anywhere 
on the drawing board.  

 
2. Choose “Display Grid” from the displayed items. The drawing board grid will be 

displayed on the active sheet. 
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The next step is to drag-and-drop the required unit processes from the Process Tool Bar to the 

drawing board. To place an influent object on the drawing board: 

3. Ensure that the Process Tool Bar is visible. 

• If not, select the “Process Tool Bar” Menu item in the “View” drop-down 
menu, “Toolbars” subsection to display the toolbar on the left side of the 
drawing board. 

 

 
 

4. Click on the “Influent” Pane Slat to reveal the Influent unit processes. 
 
5. Click and drag the “Influent Wastewater” process icon from the “Process Tool 

Bar” to the drawing board. 
 

Follow a similar procedure for: 

• a “Preliminary Treatment” object (Preliminary Treatment Pane), 

• a “Primary Clarification” object (Primary Treatment Pane), 

• a “Complete Mix Activated Sludge” object (Suspended Growth-C,N Pane), 

• and an “Ultra-Violet Disinfection” object (Tertiary Treatment Pane). 
 

After each of the objects has been placed on the drawing board, the objects must be connected to 

define the flow stream. 

6.  Place the cursor over the connection point of the influent arrow. The cursor will 
change to a white block arrow ( ). 

 
7. With the cursor as a white block arrow, click and drag a pipe to the inlet 

connection point of the preliminary treatment object. Once the cursor turns to a 
green block arrow ( ), release the mouse button. A connection pipe will be 

drawn. If an unacceptable connection is attempted, the block arrow will change 
to a red circle with a line through it ( ). 
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Note: If a mistake is made in the process of drawing connection pipes and/or 
objects on the drawing board, the incorrect items can be deleted by 
accessing the object’s edit menu  

(for incorrect objects) or the  
   upstream object’s edit menu for  
   connection pipes. 
i) Right-click on the object to  
   bring up the object’s edit menu. 
ii) Select “Delete” to remove the object 
   itself, or 
iii) Select “Delete <pipe name>  
   Connection” to remove the  
   appropriate pipe. 

 

Follow a similar procedure and draw connection pipes for each of the unit processes on the drawing 

board. A completed layout will have each object connected to one or more other objects. 
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With the process stream drawn, the next step is to specify the particulars of the process and the 

design requirements. In this example a few things will be changed from the defaults to illustrate the 

editing procedure. 

8. Right-click on the influent object to bring up the influent object’s edit menu. 
 
 
 
 
 
 
 
 
 
 

 
9. Select “Edit Influent Wastewater Parameters” from the listed items.  
 
This will display the Influent Wastewater dialog that contains several entry fields for 
entering the characteristics of the influent wastewater. In this example we will 
change only the flow and the flow units. 
 
10. Right-click on “MGD” beside the “Average Flow” entry field and display a listing 

of alternative units. 
 

11. Select “m3/d” from the list. [Note that the value in the entry field changed 
automatically to reflect the change in units.] 

 
12. Follow a similar procedure for the “Maximum Flow” units and also choose 

“m3/d” from the listed units. 
 

13. In the associated entry fields, enter 50000 for the average flow and 100000 for 
the maximum flow. 
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14. Click “Accept” to save these changes and close the window. 

 

In this next section, we will see that the calculated design is very much dependent on the solids 

retention time in the basin. Here we will make the solids retention time larger than the default 

setting and view the results.  

15. Right-click on the “Complete Mix Activated Sludge” object and bring up the 
object’s edit menu.  

 
16. Select “Edit Complete Mix Activated Sludge Parameters” from the listed items. 

 
17. In the “Complete Mix Activated Sludge” dialog, change the “Design Basis” 

drop-down menu to “Specify Design SRT” and edit the “Design SRT” to 6 days 
from 4 days. 

 



CapdetWorks V4.0  2018 

 

5-39 | Hydromantis Environmental Software Solutions, Inc. 

 
 

 
 
18. Click “Accept” to save the changes and close the window. 
 
We will also alter the design effluent suspended solids from the secondary clarifier. 
 
19. Right-click on the “Secondary Clarifier” unit and bring up the object’s edit 

menu.  
 

 
 
20. Select “Edit Secondary Clarifier Parameters” from the listed items. 
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21. In the Secondary Clarifier dialog, change the “Effluent Suspended Solids” to 
15 mg/L. 

 

 
 
22. Click “Accept”. 
 
 With these items changed, the layout can now be designed and costed. 
 
23. From the “Model” drop-down menu, choose “Estimate Cost of Current 

Layout”. [Alternatively, the layout can be designed and costed by clicking on the 

“Estimate Cost of Current Layout” button ( ) on the Tool Bar.] 
 

 
 
 

The Costing Bar now displays a summary of the estimated cost for this layout given the design 

criteria entered. In addition to getting this cost summary, it is also possible to review the details of 

the cost estimate. 
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24. From the “Model” drop-down menu, choose “View Cost Details of Current 
Layout”. [Alternatively, the details can be accessed by clicking on the “Details of 

Cost Estimate” button ( ) on the Tool Bar.]  
 

 
 

The “Details for Layout 1” window should now be displayed. This window has two sub-sections: one 

which lists the unit processes in the layout; and one which lists the particulars of the highlighted unit 

process. The unit process section is further divided into two sections: “Design Information” and 

“Wastewater Quality”.  

25. Left-click on the “Complete Mix Activated Sludge” unit process and scroll the 
“Design Information” down to view the various details of the design, including, 
for example, the total volume of the reactors. Now we shall redesign the layout, 
making the solids retention time smaller. 

 

 
 
26. Click “Close”. 
 
27. As done previously, right-click on the “Complete Mix Activated Sludge” object, 

select the “Edit Complete Mix Activated Sludge Parameters” item and display 
the Complete Mix Activated Sludge dialog.  
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28. Place the cursor over the “Design SRT” entry field and right-click. This will 
display a “Reset value to <default value>” option. 

 

 
 
29. Click on this option to reset the retention time to 4 days. 

 
30. Click “Accept”. 

 
31. Redesign the layout by selecting “Estimate Cost of Current Layout” from the 

“Model” drop-down menu. A new set of costing data will be displayed on the 
Costing Bar. 
 

 
 

32. Again, access the details window by selecting “View Cost Details of Current 
Layout” from the “Model” drop-down menu. 

 

By comparing the details generated previously with these details, you can gain some insight into the 

design algorithms. [Note: CapdetWorks has been designed specifically to facilitate the comparison 

of different designs, but this feature is beyond the scope of this initial tutorial and is described in 

more detail in Tutorial 5.] 
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33. Left-click on the Complete Mix Activated Sludge unit process, and scroll to the 
“Total volume of reactors” item under “Design Information” section. Here you 
can see that with the shorter SRT, smaller tanks are required which cost less to 
build. 

 

 
 

Thus far in this tutorial we have dealt primarily with the liquid stream; however, the sludge 

treatment stream is equally important to the design. 

34. To add a sludge stream to the layout, drag and drop: 

• a “Sludge Flotation Thickening” object (Biosolids Thickening/Dewatering 
Pane), 

• an “Anaerobic Digestion” object (Biosolids Treatment Pane), 

• a “Belt-Filter Press” object (Biosolids Thickening/Dewatering Pane), 

• and a “Hauling and Land Filling” object (Biosolids Disposal Pane) to the 
drawing board. 

 
35. Make the following connections: 

• the primary clarifier’s underflow connection to the inlet of the sludge 
thickener, 

• the secondary clarifier’s waste sludge connection (at the bottom of the 
clarifier) to the inlet of the sludge thickener, 

• the sludge outlet from the thickener to the digester, 

• the sludge outlet from the digester to the belt-filter press, 

• the sludge outlet from the belt-filter press to the hauling object, 

• and, for each of the new objects, connect the supernatant recycles to the 
inlet of the primary clarifier object. [Note the location of the particular 
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output connection points as the supernatant output connection is not 
always above the sludge output connection. 

 

 
 

 
36. With the design SRT at 4 days and the influent flows as described earlier, 

redesign the layout by selecting “Estimate Cost of Current Layout” from the 
“Model” drop-down menu. A new set of costing data will be displayed on the 
Costing Bar. 

  
37. Display the details of the cost estimate by selecting “View Cost Details of 

Current Layout” from the “Model” drop-down menu. 
 

The details of the cost estimate are the crucial part of the design. It is important to realize how the 

costs are calculated and how they are grouped together. For instance, aeration is not associated 

with its unit process, but rather a blower system for the whole plant is designed irrespective of what 

processes require air. Hence, aeration costs in this example are not associated with the complete 

mix activated sludge process.  You will find that a separate unit process, “Blower System”, is in the 

list at the top of the details window. The details of this blower system encompass the total air 

requirement for the whole plant. 
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38. With the Details for Layout 1 window open, click on the “Blower System” unit 
process. 

 

 
 

Note that the Wastewater Quality section of this window is now blank. This occurs because there is 

no flow through the blower system. Other items and unit processes (e.g. “Other Costs” and chemical 

additions) are handled in the same way and do not have associated wastewater quality data. 

39. Click “Close”. 
 
40. With this tutorial now complete, save the layout by selecting “Save” (or “Save 

As”) from the “File” drop-down menu. 
 
41. In the displayed dialog, navigate to an appropriate directory (if required) using 

the standard navigation tools at the top of the dialog. 
 
42. Type a file name into the “File name” entry field. 
 
43. Click “Save”. 

 

This example has provided a simple illustration of the basic drawing and designing features of 

CapdetWorks. Future tutorials will address more complex issues including customization, overriding 

the design, sensitivity analysis, and layout design comparisons. 
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5.3  Tutorial 2 
 

Customizing Costing Parameters 

This tutorial covers the following topics: 

1. Customizing unit costs 
2. Updating the costing indices 
3. Creating and editing a new equipment database  

 

Customizing Unit Costs  

Start CapdetWorks, if not already running, and load the Tutorial 1 layout. 

1. To open the Tutorial 1 layout:  

• choose it from the list of most recent files in the “File” drop-down menu. 

• select “Open” from the File drop-down menu. 

• click on the “Open” button ( ) found on the Tool Bar. 
 

2. If one of the two latter options is used, browse to the location of the tutorial 
files and select “Tutorial 1.cwl” (or applicable file name) from the listed layouts 
in the “Open” dialog. 

 
3. Click “Open”. 

 

This will load the Tutorial 1 layout, which we will be used as the basis for this tutorial. 

The Unit Costs dialog is used to customize CapdetWorks costs to local non-unit process specific costs 

including such things as concrete, labor, chemicals and interest rates. 

4. Access the Unit Costs dialog by selecting “Unit Costs” from the “Cost Data” 
drop-down menu.   
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5. On the “Unit Costs” tab, change: 

• “Building Cost” to 150 $/sqft (under Unit Costs tab), 

• “Wall Concrete” to 700 $/cuyd (under Unit Costs tab), 

• “Slab Concrete” to 400 $/cuyd (under Unit Costs tab), 
 

 
 
6. On the “Region Specific” tab, change the “Electricity” to 0.15 $/kWh. 
 
7. On the “Financial” tab, change the “Interest Rate” to 6%. 
 
8. On the “Other Costs” tab, change the “Engineering Design Fee” to 10%. 
 
9. Click “Accept”. 
 
10. Redesign the layout by selecting “Estimate Cost of Current Layout” from the 

“Model” drop-down menu. A set of costing data will be displayed on the Costing 
Bar.  

 

Access the Complete Mix Activated Sludge dialog by right-clicking on the activated sludge object and 

selecting the “Edit Complete Mix Activated Sludge Parameters” menu item. 

11. Click on the “Equipment” tab. 
 
12. Bring the cursor over the “Slow Speed 20 hp Aerator” entry field – DO NOT 

CLICK.  
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This action will bring up a tool tip, which shows the default value, the equipment database value, 

the costing index used to alter the cost of that piece of equipment with time, the current value of 

that cost index, and the historical index value. This feature gives the user a quick method to 

determine the basis for a particular cost estimate. 

13. Click “Accept” or “Cancel” to close the dialog. 

Customizing the Costing Indices 

14. Access the Cost Indices dialog by selecting “Cost Indices” from the “Cost Data” 
drop-down menu. 

 

 
 

15. Change the “HECI – Hydromantis Equipment Cost Index” value to 105, “HCCI – 
Hydromantis Construction Cost Index” value to 112, and “HECI – Hydromantis 
Pipe Cost Index” value to 104. 
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The up to date values for the Hydromantis pre-defined costing indices may be retrieved by 
clicking the “Update” button on the form. If you are using standard database based on Marshall 
and Swift (MAS), Engineering News Record (ENR) and Chemical Engineering (PIPE) indices, you 
will need to refer to these journals for latest values. 
 
When you change a value from its default, it can be helpful to add a note to indicate why it was 
changed. In this case, we made up the number, but we’ll pretend that these new indices are 
from April 2018. 
 

16. Click the “Notes” button ( ) beside the Hydromantis Equipment Cost Index. 
 

17. In the dialog window that appears, type “Current value as of April 2018”. 
 

 
 
18. Click “Accept”. 

 
19. Note that the icon beside the Hydromantis Equipment Cost Index has changed (

) to indicate that a note is present. Bring the cursor over the button to display 
the tool tip, which is the note that was typed into the dialog window. 
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20. Add a similar note to the Hydromantis Construction Cost Index. 
 

21. Click “Accept”. 
 

22. Click on the “Edit Complete Mix Activated Sludge Parameters” option by right-
clicking on the unit and click on the “Equipment” tab. 
 

23. Once again, bring the cursor over the “Slow Speed 20 hp Aerator” entry field to 
bring up the tool tip. 

 

 
 
24. See that the value in the entry field has been automatically updated based on 

the new index value and the tool tip also has been updated to reflect this 
change. 

 
25. Click “Accept” or “Cancel” to close the dialog. 

Customizing the Equipment Database 

26. Access the Equipment Costs window by selecting “Equipment Cost Database” 
from the “Cost Data” drop-down menu. 
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CapdetWorks includes five pre-defined equipment databases: 

• Hydromantis 2014, (USA Avg.) 

• Standard 2014,(USA Avg.) 

• Sept 2007,(USA Avg.) 

• July 2000, (USA, Avg.) 

• 1977, (USA, Avg.) 
 

These databases are not editable; however you can create your own databases based on these ones. 

You can toggle through the available databases using the “Equipment Cost Database” drop-down 

box near the top of the window. 

27. Using the “Equipment Cost Database” drop-down box, select the “Hydromantis 
2014, (USA, Avg.)” item if not already chosen. 
 

28. Click the “Create new database” button ( ), and enter a name for the 
database when prompted. 
 

 
 



CapdetWorks V4.0  2018 

 

5-52 | Hydromantis Environmental Software Solutions, Inc. 

 
 

29. Click “OK”. You should now be able to see the new database listed in the 
database drop-down box. It is also important to recognize that the new 
database is an exact copy of active database when the “Create new database” 
button was clicked. In this case the new database is a copy of the “Hydromantis 
2014, (USA Avg)” database. 

 

 

30. If not already showing, choose the new database from the list of available 
databases. 

 
31. In the “Find” entry field, type “slow”. 
 
32. Click “Search”. 
 
33. Scroll through the database window and you will discover that every equipment 

description with the word “slow” in it, is highlighted in blue. 
 
34. Scroll through the window and find “Slow speed, pier mounted 20 hp aerator”. 
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As seen previously in the “tool tip” of the equipment in the Complete Mix Activated Sludge dialog 

window, you will see the base “Cost”, the applicable “Cost Index” and the “Value of Cost Index” 

columns. The cells in this table are editable.  

35. Click on the “Cost” column cell and enter 24000 ($ sign and decimals are not 
required) in the “Cost” entry field. 

 
36. Click on the “Value of Cost Index” column cell and enter 105 in the entry field. 

Press “Enter”. 
 
37. Click “Accept” to save the database creation and edits. 

 

 
 

38. With the Main Window now active, select the newly created database from the 
“Equipment Costing Database” drop-down box found on the Tool Bar. 

 
 
39. Redesign the layout by selecting “Estimate Cost of Current Layout” from the 

“Model” drop-down menu. A set of costing data will be displayed on the Costing 
Bar. 

 
40. Return to the Complete Mix Activated Sludge dialog and click on the 

“Equipment” tab. 
 
41. Once again, bring the cursor over the “Slow Speed 20 hp Aerator” entry field to 

bring up the tool tip. 
 
42. See that the value in the entry field has been automatically updated based on 

the new database cost value of $24000.00, and no adjustment for time has been 
made because the updated cost estimate was input at the current index value. 
Note that the tool tip has been updated to reflect the information in the new 
database. 

 
43. Click “Accept” or “Cancel” to close the dialog. 
 
44. With this tutorial now complete, save the layout by selecting “Save As” from the 

“File” drop-down menu. 
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45. In the displayed dialog, navigate to an appropriate directory (if required) using 

the standard navigation tools at the top of the dialog. 
 
46. Type a file name into the “File name” entry field. 
 
47. Click “Save”. 

 

This tutorial has provided an introduction to some of the customizable costing features included in 

CapdetWorks. Specifically this tutorial has addressed some of the features that will be important for 

the localization of the costing algorithms so that the CapdetWorks design is consistent with the local 

conditions. 
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5.4  Tutorial 3 

Overriding a Design 

This tutorial covers the following topics: 

1. Overriding the physical design 
2. Overriding the unit process equipment costs 
3. Overriding the blower design safety 
4. Overriding the unit process overall costs 

 

Overriding the Physical Design 

Start CapdetWorks, if not already running, and load the Tutorial 2 layout. 

1. To open the Tutorial 2 layout:  

• choose it from the list of most recent files in the File drop-down menu. 

• select “Open” from the File drop-down menu. 

• click on the “Open” button ( ) found on the Tool Bar. 
 

2. If one of the two latter options is used, browse to the location of the tutorial 
files and select “Tutorial 2.cwl” (or applicable file name) from the listed layouts 
in the “Open” dialog. 

 
3. Click “Open”. 

 

This will load the Tutorial 2 layout, which we will be used as the basis for this tutorial. 

By default, CapdetWorks assumes the use of the Hydromantis 2014,(USA Avg.) database. For this 

tutorial we will use the newly created database from Tutorial 2. 

4. Select the “Tutorial2” database from the “Equipment Costing Database” drop-
down box found on the Tool Bar (if not already selected).  

 
5. Design the layout by selecting “Estimate Cost of Current Layout” from the 

“Model” drop-down menu. A set of costing data will be displayed on the Costing 
Bar. 

 
6. Right-click on the “Complete Mix Activated Sludge” object to bring up the 

object’s edit menu. 
 
7.  Select “Edit Complete Mix Activated Sludge Parameters” from the listed items. 
 
8. Click on the “Design Override” tab. 
 
9. Check the “Override Design” checkbox. 
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By checking the “Override Design” checkbox, you will gain access to the characteristics of the design. 

In this example we will alter just a few physical characteristics to introduce the required 

methodology. 

Note: The “Override Design” entry fields are defaulted to zero if the layout 
has not been costed. Therefore, if the entry fields display zeros, then 
uncheck the checkbox and cost the layout (Step “5” above). Then return 
to this dialog and check the checkbox. 

 

10. Change the “Number of Tanks” to 4, the “Tank Width” to 15m (to keep the tank 
length the same), and the “Excavation Depth” to 2m. 
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11. Click “Accept”. 
 

12. Next, right-click on the “Secondary Clarifier” object to bring up the object’s edit 
menu. 

 
13.  Select “Edit Secondary Clarifier Parameters” from the listed items. 
 
14. Click on the “Design Override” tab. 
 
15. Check the “Override Design” checkbox. 
 
16. Change the “Excavation Depth” to 9 ft. 
 

 
 
17. Click “Accept”.  
 
18. Redesign the layout by selecting “Estimate Cost of Current Layout” from the 

“Model” drop-down menu. A set of costing data will be displayed on the Costing 
Bar.  

 

 
 

This section has simply been meant to demonstrate that even minor changes to the design (i.e. 

sinking the tanks further into the ground in this case) will impact on the costing calculations. Next 

we will examine a slightly more complicated override procedure. 

Overriding the Unit Process Equipment Costs 

19. Right-click on the “Belt-Filter Press” object to bring up the object’s edit menu. 
 
20. Select “Edit Belt-Filter Press Parameters” from the listed items. 
 
21. Click on the “Equipment” tab. 
 
22. Check the “Override Database Costs” checkbox. 
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You’ll notice that two belt filtration systems are listed, but there is no information on which one the 

design is using. 

23. Change nothing and click “Accept”. 
 
24. From the “Model” drop-down menu, choose “View Cost Details of Current 

Layout”. [Alternatively, the details can be accessed by clicking on the “Details of 

Cost Estimate” button ( ) on the Tool Bar.]  
 
25. Scroll the Layout 1 unit process list and click on “Belt Filter-Press”. 

 
26. Under “Design Information” in the particulars sub-section you can see that a 

2m belt filtration unit was used in the design. 
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27. Close the details window. 

 
28. Right-click on the “Belt Filter-Press” object to bring up the object’s edit menu. 

 
29. Select “Edit Belt Filtration Parameters” from the listed items.  

 
30. Click on the “Equipment” tab. 

 
31. Check the “Override Database Costs” checkbox if not already checked. 

 
32. Change the “2m Belt Filter System” cost to $300000.  
 

 
 
33. Click “Accept”. 
 
34. Redesign the layout by selecting “Estimate Cost of Current Layout” from the 

“Model” drop-down menu. A set of costing data will be displayed on the Costing 
Bar. 

 

Overriding the Blower Design Safety 

The blower system is a special case and is not represented by an icon on the drawing board. First, 

we will view how the blower is designed by default.  

35. From the “Model” drop-down menu, choose “View Cost Details of Current 
Layout”. [Alternatively, the details can be accessed by clicking on the “Details of 

Cost Estimate” button ( ) on the Tool Bar.]  
 

36. Scroll the Layout 1 unit process list and click on “Blower System”. 
 

37. Under “Design Information” in the particulars sub-section you can see the first 
three parameters are minimum air flow capacity, safety factor, and required air 
flow capacity. 

 



CapdetWorks V4.0  2018 

 

5-60 | Hydromantis Environmental Software Solutions, Inc. 

 
 

38. Click “Close”. 
Next we will investigate how the blower safety factor can be overridden. 

39. Select “Edit Blower System” from the “Model” drop-down menu. 
 

40. On the first tab, change the safety factor from 1.5 to 1. 
 

 
 
41. Click “Accept”. 

 
42. Redesign the layout and view the details by clicking on the “Details of Cost 

Estimate” button ( ) on the Tool Bar. 
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43. Scroll to the Blower System and notice that the minimum air flow capacity and 
the requested air flow capacity are now the same. 

 
44. Click “Close”. 

Overriding the Unit Process Overall Costs 

Occasionally, some of the costs for a particular unit process may already be known, 
and due to the differences between various locales, they might disagree with the 
values from the CapdetWorks algorithms. In this case, the seven different costs 
(construction, operation, maintenance, materials, chemical, energy, and 
amortization) can be individually overridden. In this example, we will change the 
maintenance and materials costs for the Ultra-Violet Disinfection unit. 

 
45. Right-click on the “Ultra-Violet Disinfection” object to bring up the object’s edit 

menu. 
 

46. Select “Edit Cost Override Parameters” from the listed items.  
 

47. Select the checkbox beside the “Override Annual Maintenance Cost” and enter 
25000 into the corresponding entry field. 
 

48. Select the checkbox beside the “Override Annual Materials Cost” and enter 
100000 into the corresponding entry field. 

 

 
 
49. Click “Accept”. 
 
50. Redesign the layout and view the details by clicking on the “Details of Cost 

Estimate” button ( ) on the Tool Bar. 
 
51. Scroll to the Ultra-Violet Disinfection item and notice that the maintenance and 

materials values are equal to the values that you entered. Also notice that these 
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values are absent from the “Estimated Costs” section in the details table of the 
Ultra-Violet Disinfection unit, in order to indicate that they are not being 
calculated from the CapdetWorks algorithms. 

 

 
 
52. Click “Close”. 
 
53. With this tutorial now complete, save the layout by selecting “Save As” from the 

“File” drop-down menu. 
 

54. In the displayed dialog, navigate to an appropriate directory (if required) using 
the standard navigation tools at the top of the dialog. 
 

55. Type a file name into the “File name” entry field. 
 

56. Click “Save”. 
 

This tutorial has provided an introduction to some of the design overriding features included in 

CapdetWorks. Specifically, this tutorial has addressed some of the features that will be important for 

the localization of the design so that the CapdetWorks design is consistent with the local conditions, 

preferences and safety concerns. 
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5.5  Tutorial 4 

Performing a Sensitivity Analysis 

This tutorial covers the following topics: 

1. Performing a plant-wide sensitivity analysis 
2. Analysis of a unit process sensitivity 

Performing a Plant-wide Sensitivity Analysis 

Start CapdetWorks, if not already running, and load the Tutorial 3 layout. 

1. To open the Tutorial 3 layout:  

• choose it from the list of most recent files in the File drop-down menu. 

• select “Open” from the File drop-down menu. 

• click on the “Open” button ( ) found on the Tool Bar. 
 

2. If one of the two latter options is used, select “Tutorial 3.cwl” (or applicable file 
name) from the listed layouts in the “Open” dialog.  
 

3. Click “Open”. 
 
This will load the Tutorial 3 layout which we will be used as the basis for this tutorial. 

For this tutorial we will use the default equipment database “Hydromantis 2014, (USA Avg)”. 

4. If not already selected, on the Tool Bar, from the “Equipment Costing 
Database” drop-down box, select the “Hydromantis 2014, (USA Avg.)” 
database. 

 
5. Right-click on the Complete Mix Activated Sludge unit and select “Edit Complete 

Mix Activated Sludge Parameters”. 
 

6. Access the “Design Override” tab in the Complete Mix Activated Sludge dialog 
and uncheck (if checked) the design override check box. 

 
7. Click “Accept”. 
 
8. Redesign the layout by selecting “Estimate Cost of Current Layout” from the 

“Model” drop-down menu. A set of costing data will be displayed on the Costing 
Bar. 

 
9. Select “Sensitivity Analysis” from the “Analysis” drop-down menu. 

 
This will display a blank Sensitivity Analysis window that will be used to demonstrate how 

CapdetWorks can be used to investigate uncertainties in some of the assumed design criteria. 

The Sensitivity Analysis window has several features for setting up the analysis. 
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The “Process” drop-down box lists all the unit processes on the drawing board and the “Parameter” 

drop-down box lists the available parameters for the chosen process.  

10. Click on the “Process” pull-down menu to familiarize yourself with the listed 
process. If not already chosen, choose “Influent Wastewater” from the drop-
down menu. 

 
11. Click on the “Parameter” pull-down menu to see the available parameters. For 

this initial example, choose “Average Flow” from the listing. 
 
Next we will set the range for the independent variable (in this case “Average Flow”) using the two 

slider control objects. 

12. Change the “Low value” to 12500 m3/d and hit “Enter”. 
 

13. Similarly, set the “High value” to 150000 m3/d and hit “Enter”. 
 

 
 
14. Click the “Run Analysis” button. 
 



CapdetWorks V4.0  2018 

 

5-65 | Hydromantis Environmental Software Solutions, Inc. 

 
 

The analysis window will now be displaying a graph with the independent variable (Average Flow) 

on the X-axis and the dependent variable (Cost) on the Y-axis. [Note that the X-axis scale has been 

set to the limits previously defined with the sliders.] 

The legend for this graph indicates six curves, but in this example only 3 curves are clearly visible. 

This is because the Y-axis scale is automatically scaled to fit the largest quantities. However, the Y-

axis scale can be changed using the directional keys to the left of the graph. 

 

You’ll notice that the Y-axis scale changes with each click and that the visible curves adjust 

accordingly.  Using this feature will allow you to see any of the curves of interest.  

15. Click on the “Decrease Scale” button several times.  
 

 

Increase scale 

Reset scale to default 

Decrease scale 
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This analysis showed the impact of average flow on the total costs of the plant. It also is possible to 

examine the impact of a parameter on the individual unit process. 

Analysis of a Unit Process Sensitivity 

16. Using the Process drop-down box, select “Primary Clarification” from the unit 
process listing. 
 

17. If not already selected, select “Surface Overflow Rate” from the Parameter 
drop-down box. 
 

18. Click the “Run Analysis” button.  
 

 
 

The displayed graph indicates that the surface overflow rate has a minimal impact on the cost of the 

plant. However, it may be of interest to examine the impact on the Primary Clarification unit process 

itself. 

19. Click on the “Process Impact” tab. 
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Using the graph on this tab, it is possible to see that although the surface overflow rate has a 
minimal impact on the overall cost of the plant, it does have a significant impact on the costs 
associated with the Primary Clarification unit process.  
 

20. Click the “Copy to clipboard” button ( ) to place an image of the graph onto 
the system’s clipboard. 
 

21. Open a word processor or spreadsheet program (eg. Microsoft Word/Excel), 
and use the “Paste” command within that program to copy the image into it. 

 
22. With this tutorial now complete, save the layout by selecting “Save As” from the 

File drop-down menu. 
 

23. In the displayed dialog, navigate to an appropriate directory (if required) using 
the standard navigation tools at the top of the dialog. 
 

24. Type a file name into the “File name” entry field. 
 

25. Click “Save”. 
 

This tutorial has provided an introduction to some of the sensitivity analysis features included in 

CapdetWorks. Specifically, this tutorial has addressed setting up the analysis, manipulating the 

output graph, and analyzing the impact of a parameter on the entire plant or simply the specific unit 

process.  
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5.6  Tutorial 5 

 

Comparing Alternative Designs 

This tutorial covers the following topics: 

1. Data linking similar objects  
2. Comparing alternative process designs 
3. Printing a report of the design results 

 

Data Linking Similar Objects 

For the initial section of this investigation we will create a new layout. 

1. Select “New” from the “File” drop-down menu. 
 

2. Drag an “Influent Wastewater” object to the drawing board. 
 

3. Drag a “Primary Clarification” object to the drawing board. 
 

4. Connect the flow stream from the influent object to the primary clarifier. 
 

 
 
5. Design the layout by selecting “Estimate Cost of Current Layout” from the 

“Model” drop-down menu. A set of costing data will be displayed on the Costing 
Bar. 

 

 
 
With this simple layout costed, we will examine some of the comparison features of CapdetWorks. 

6. Right-click on the tab name at the bottom of the drawing board to bring up the 
tab edit menu. 

7. Select “Duplicate” from the listed items. 
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This operation inserts a duplicate layout into the project on a new tab. It also creates linked objects 

as signified by the data link indicator on the drawing board object. In this case, both the influent 

object and the primary clarifier object are linked to the original objects on tab “Layout 1”. 

 

 

Note: By linking objects, users can ensure continuity in different layouts. This 
feature should also decrease the number of data entry errors because 
data need only be entered once for linked objects. Further, any editing 
can be done using the parent object’s edit menu OR the dependent 
object’s edit menu. It also should be noted that all the data in the edit 
menu is linked, including the design overrides. In this example, we will 
examine this feature in a little more detail. 

 

8. Right-click on the Primary Clarification object and bring up the object’s edit 
menu. 
 

9. Highlight the “Link Data” menu. 
 

10. Select “Remove Link to Data…” from the displayed listing. 
 

 
 

Data Link Indicator 

Dependent Object 
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11. Confirm the removal of the link by clicking “Yes”.  
 

This operation will remove the primary clarifier link, but the influent object will remain intact. 

 

12. Right-click on the Primary Clarification object to bring up the object’s edit menu. 
 
13. Select “Edit Primary Clarification Parameters” from the listed items. 
 
14. On the Primary Clarification tab, change the “Type of Clarifier” from circular to 

rectangular. 
 

 
 
15. Click “Accept”.  

 

16. Rename this layout (ie. “Layout 1(2)”) by right-clicking on the tab and selecting 
“Rename” from the menu. 
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17. Type “Rectangular” when prompted for a new name and click “OK”. 
 
18. Go back to the first layout’s tab (“Layout 1”). 

 
19. Rename this tab to “Circular”. 
 

 
 

Now we will compare the designs.  

20. Select “View Cost Details of All Layouts” from the “Model” drop-down menu. 
[Note that by choosing this option all layouts in the file will be automatically 
redesigned.] 

 

 
 
The “Summary of All Layouts” window is split into two sections. The table at the top displays each 

layout within the project and a summary of its associated costs. The tabbed area that takes up the 

rest of the window displays the details of each layout. There is one tab for each layout. 

 

 

Summary of all 

layouts within the 

project 

 

 

Details of each 

layout displayed 

in a tabbed 
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By flipping back and forth between the tabs, you can compare the differences between the resulting 

design information. 

21. Click “Close”. 
 

22. Save this layout by selecting “Save As” from the “File” drop-down menu. 
With the initial introduction to linking objects and comparing layouts complete, the next step is to 

move on to our previous layout and compare an alternative design. 

Comparing Alternative Process Designs 

For this part of the tutorial, we will begin with the layout created in Tutorial 2. 

 

23. Open the Tutorial 2 layout. 
 
24. If not already selected, on the Tool Bar, from the “Equipment Costing 

Database” drop-down box, select the “Hydromantis 2014, (USA Avg.)” 
database. 

 
25. Right-click on the tab name at the bottom of the drawing board to bring up the 

tab edit menu. 
 

26. Select “Duplicate” from the listed items. 
 

27. Name the new layout “Trickling Filter” when prompted. 
 

28. Click “OK”. 
 

29. Rename “Layout 1” to “Activated Sludge”. 
 
30. Click on the “Trickling Filter” tab to bring that layout to the foreground. 
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31. Right-click on the dependent Complete Mix Activated Sludge object to bring up 
the object’s edit menu.  
 

32. Select “Delete” from the listed menu items. 
 

 
 
33. Click “Yes” to both questions (this will delete the activated sludge object and its 

clarifier). 
 
34. Click on the “Attached Growth” pane on the Process Tool Bar. 

 
35. Drag a “Trickling Filter” object to the drawing board. 
 
36. Add the following flow stream connections: 

• the primary clarifier to the trickling filter 

• the secondary clarifier to the ultra-violet unit process 

• the waste sludge flow from the bottom of the secondary clarifier to the 
sludge flotation thickening object.  

 
37. Create a data link between the “Trickling Filter” clarifier and the “Activated 

Sludge” clarifier.  
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38. Select “View Cost Details of All Layouts” from the Model drop-down menu. 
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From this analysis we can see that the activated sludge design is significantly more expensive than 

the trickling filter design. It is possible to see from the summaries that the activated sludge system is 

more expensive in most categories, but particularly in the energy category. 

39. Select the “Activated Sludge” tab and click on the “Anaerobic Digestion” unit 
process. 
 

40. In the Design Information section, scroll down to the “Quantities Required” 
area of the table. 
 

41. Switch to the “Trickling Filter” tab and browse to the same area. 
 

This procedure allows you to see some of the differences created by substituting the trickling filter 

for the activated sludge unit. It is interesting to note that not only is there a difference in design 

costs because of the unit process change, but these unit processes also have an impact on the 

design of the other unit processes in the layout. 

42. Click “Close”. 
 

 Generating a Report 

It is interesting to be able to see the details of the design on the screen, but it may be of interest to 

also generate a printout of the results. 

43. Select “Generate Report…” from the “Model” drop-down menu. 
 

This action will bring up the “Report Setup” dialog that is used to set the report attributes. There is a 

checkbox next to each layout name which allows you to select one or more layouts to be included in 

the report. The following steps will take you through the report setup procedure. 

44. Ensure that both the “Activated Sludge” and “Trickling Filter” checkboxes are 
selected. 
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Note that if only one layout is chosen, the “Layout Comparison Summary” checkbox is grayed-out, 

but if more than one is selected, the checkbox is available. 

45. Select the attributes you would like in the report. 
 

46. Select the format for the file that will be generated. 
 

47. Click “Accept” and select a file name and location when prompted. 
 

48. If the “view report upon completion” checkbox was selected, once the report 
has been generated it will open in its associated program (eg, Word, Excel, etc). 

 
49. With this tutorial now complete, save the layout by selecting “Save As” from the 

“File” drop-down menu. 
 

This tutorial has provided an introduction to some of the linking, de-linking and comparative 

features included in CapdetWorks. Specifically, this tutorial has addressed some of the features that 

will be important for comparing alternative designs. Finally, this tutorial included an introduction to 

generating a report of the results of an evaluation.  

Listing of 

layouts in the 

project (one or 

more can be 

individually 

selected) 

File Format 

Options 

Content 

Options 
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6. How To: 
6.1  Generate Output Data 

Generate a Report 

 

Tip:  Reports can be generated in several different file formats. The default 
option is an “Excel” file, which can be opened Microsoft Excel as well as 
many different spreadsheet programs. They can also be generated as 
“Rich Text Format” files, which can be opened in most word processing 
programs (Microsoft Word, etc.). Or it can be generated as a tab 
delimited plain text file, which can be opened in almost any program, 
but will required more manual formatting by the user to make the 
information more presentable. 

 
1. Access the Report Setup dialog box by selecting “Generate Report…” from the 

“Model” menu found on the Menu Bar. 
 

 
 
2. If the current project contains more than one layout, choose which layouts to 

include in the report in the “Layout Selection” section. 
 

3. Choose the type of data to include in the report in the “Options” section. 
 

4. Choose the type of report to generate in the “File Format” section. 
 

5. Choose whether the generated report should automatically open in its 
associated program after completion by selecting or deselecting the “view 
report upon completion” checkbox. 
 

6. Click “Accept”. 
 

7. Choose the filename and location in the file dialog box that appears. 
 

8. Click “Save” 
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Print Layout 

To print the drawing board: 

1. Select “Print Layout” from the “File” menu found on the Menu Bar.  
 

 
 

Alternatively: 

1. Access the drawing board edit menu by right-clicking on white space anywhere 
on the drawing board.  
 

2. Choose “Print Layout” from the displayed items. 

Listing of 

layouts in the 

project (one or 

more can be 

individually 

selected) 

File Format 

Options 

Content 

Options 
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6.2  Manage Drawing Board Unit Processes 

Select Area 

One or more drawing board unit processes can be simultaneously selected and manipulated (i.e. 

moved, cut, copied…). 

Entire Drawing Board 

To select the entire drawing board area: 

1. Select “Select All” from the “Edit” menu found on the Menu Bar.  
 

 
 

Portion of the Drawing Board 

To select only a portion of the drawing board area: 

1. Use the mouse to form an inclusive box around the unit process(es) of interest. 
A red selection box will be drawn on the drawing board to indicate the selected 
area. 

 
2. Once one or more cells have been selected, the cut and copy functions can be 

used. 
 
 

 
 
 

 
 
 
 

 

Selected Area 

Inclusive Box 
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Individual Unit Process 

To select only one unit process: 
1. Left-click on the unit process. 

Unselect Area 

To unselect the selected area of the drawing board: 

1. Select “Remove Selection Box” from the “Edit” menu found on the Menu Bar. 
The red selection box surrounding the selected area will be removed from the 
drawing board.  

 
Alternatively: 

1. Access the drawing board edit menu by right-clicking on white space anywhere 
on the drawing board.  
 

2. Choose “Remove Selection Box” from the displayed items. The red selection 
box surrounding the selected area will be removed from the drawing board. 

 

Tip: The selection box also can be removed from the 
drawing board by drawing a very small inclusion 
box that does not include a full grid cell.  

 

Note: “Remove Selection Box” DOES NOT delete the 
selected unit processes from the drawing board. 
The function of this command is simply to clear 
the drawing board of any selected area. 

 

Cut 

The “Cut” command can be used to remove unit processes from the drawing board and put a copy 

of them onto the clipboard, so that they can be pasted into a different location. 

To use the “Cut” command: 

1. Select an area of the drawing board. (see “Select Area” section of this “How 
To…” chapter) 
 

2. Select the “Cut” command using one of three methods: 

• Click on the shortcut button ( ) on the Toolbar; or, 

• Select “Cut” from the Edit Menu found on the Menu Bar; or,  

• Access the drawing board edit menu by right-clicking on white space 
anywhere on the drawing board, and select “Cut” from the displayed menu.  
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Copy 

The “Copy” command puts a copy of the selected unit processes onto the clipboard, so that they can 

be pasted into a different location. 

To use the “Copy” command: 

1. Select an area of the drawing board. (see “Select Area” section of this “How 
To…” chapter) 
 

2. Select the “Copy” command using one of three methods: 

• Click on the shortcut button ( ) on the Toolbar; or, 

• Select “Copy” from the Edit Menu found on the Menu Bar; or, 

• Access the drawing board edit menu by right-clicking on white space 
anywhere on the drawing board, and select “Copy” from the displayed 
menu.  

 

Tip: A “quick key” procedure for copying a single object on the drawing board 
is also available. While holding down the <Ctrl> key, left-click the object 
to be copied and drag the duplicate object to an unoccupied grid cell. 

Paste  

The “Paste” command is used to transfer unit processes from the clipboard to the drawing board. 

To use the “Paste” command: 

1. Select the area of the drawing board where you would like to place the 
clipboard objects. (see “Select Area” section of this “How To…” chapter) 

 
2. Select the “Paste” command using one of three methods: 

• Click on the shortcut button ( ) on the Toolbar; or, 

• Select “Paste” from the Edit Menu found on the Menu Bar; or, 

• Access the drawing board edit menu by right-clicking on white space 
anywhere on the drawing board, and select “Paste” from the displayed 
menu.  

 

Note: If any objects occupy any of the required grid cells for the clipboard 
objects, the paste command will display an overwrite warning. 
Proceeding with the paste will result in the loss of the overwritten 
objects.  
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Note: If the clipboard objects were copied then the “Paste” command 
creates duplicate objects on the drawing board that are data linked to 
the original objects. The reader is referred to the “Manage Data Links” 
section of this “How To…” chapter to learn about linking object data and 
deleting existing links. 

Delete 

Delete: Single Unit Process 

To “Delete” a single layout object: 

1. Access the object’s edit menu by right-clicking on the unit process object. 
 

2. Select “Delete” from the displayed menu. 

Delete: Selection of Unit Processes 

To “Delete” a selection of unit processes: 

1. Select an area of the drawing board that encompasses all of the unit processes 
that are to be removed. (see “Select Area” section of this “How To…” chapter) 
 

2. Select the “Delete” command using one of two methods: 

• Select “Delete” from the Edit Menu found on the Menu Bar; or, 

• Access the drawing board edit menu by right-clicking on white space 
anywhere on the drawing board, and select “Delete” from the displayed 
menu. 

Delete: Layout 

To “Delete” an entire layout: 

1. Open the layout that needs to be deleted. 
 
2. Select “Delete” from the “Layout” menu found on the Menu Bar. 

 

Change Orientation (Reflect/Rotate) 

To change the orientation of a unit process on the drawing board, the “Reflect” and/or “Rotate” 

commands can be used: 

1. Select an area of the drawing board that encompasses all of the unit processes 
that are to be reflected/rotated. (see “Select Area” section of this “How To…” 
chapter) 
 

2. Select the “Reflect” or “Rotate” command using one of two methods: 

• Click on one of the shortcut buttons ( , ) on the Toolbar; or, 

• Select “Reflect” or “Rotate” from the Edit Menu found on the Menu Bar. 
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Clear the Clipboard 

To clear the clipboard: 

1. Select “Clear Clipboard” from the “Edit” menu found on the Menu Bar. This 
function clears the clipboard and renders the paste function unavailable until a 
new selection is cut or copied. 

 

Move Unit Processes 

Unit processes on the drawing board can be moved around the drawing board one at a time, or as a 

group. 

A Single Unit Process 

To move a single unit process: 

1. Left-press on the unit process and while keeping the left mouse button 
depressed, drag the unit process to its new location. Any connections to that 
object will be adjusted to the new location. During the drag operation the unit 
process will be “grayed out” to indicate which object is being moved. 

A Selection of Unit Processes 

To move a selection of unit processes: 

1. Select an area of the drawing board that encompasses all of the unit processes 
that are to be removed. (see “Select Area” section of this “How To…” chapter) 

 
2. Left-press on one of the selected unit processes and while keeping the left 

mouse button depressed, drag the unit process to its new location. The other 
selected unit processes will automatically move accordingly. 

 

6.3  Manage Unit Process Connections 

Connect Unit Processes – Drawing the Flow Stream 

To connect a flow stream between two unit processes: 

1. Position the cursor over the effluent connection point of an upstream unit 
process. A successful positioning will result in a change in the cursor icon to a 
white block arrow ( ). 

 
2. While holding down the left mouse button, drag the cursor to an influent 

connection point on a downstream object. Allowable connections are signified 
by a change in the block arrow from white to green ( ).  

 
If an unacceptable connection is attempted, the block arrow will change to a red 
circle with a line through it ( ).  
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Note: Many objects have two distinct input locations: one for  
a sludge stream and one for a liquid stream. If at first  
a connection is not allowed, you should try different  
vertical positions on the object (Note that the possible  
connection points can be displayed on the drawing  
board. Refer to “Display the Unit Process Connection  
Points” in this chapter. Also note that all objects allow  
multiple flow streams to the same input location. 

 

Delete Connections 

To delete a connection between two unit processes: 

1. Right-click on a unit process. 
 

2. Select “Delete Wastewater Connection” or “Delete Sludge Connection” from 
the displayed menu. 

 

6.4  Manage Data Links 
To minimize the required data entry, CapdetWorks gives the user the ability to link similar unit 

processes. This creates a parent object and one or more dependent objects. The dependent objects 

inherit process data from the parent object; thus, minimizing the data entry for similar objects, 

which should minimize the chance of data entry error for objects that are meant to be identical.  
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Create a Unit Process Link 

To create a data link: 

1. Access the dependent unit process’ edit menu by right-clicking on the unit 
process. 
 

2. Select the “Link Data” menu item.  
 

3. Choose the desired parent object from the list of identical unit process objects. 
 

Note: With linked objects, all subsequent changes to the parent object data 
will automatically be reflected in the dependent object data. 

 

 

Dependent Object 

Parent Object 

Data Link  

Indicator 
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Delete a Unit Process Link 

To delete a data link: 

1. Access the dependent unit process edit menu by right-clicking on the unit 
process object. 
 

2. Select “Remove Link to Data” from the menu list. 
 

Note: This delete link operation removes the link to the parent object and 
creates an independent object with its own process data. 

 

 
 

6.5  Manage Layouts and Layout Tabs 

Customize the Name of a Layout Tab 

To change the name of a layout tab: 

3. Access the tab edit menu by right-clicking on the tab name.  
 

4. From the displayed menu choose “Rename”. 
 

5. Type a new name in the displayed entry field. 
 

6. Click “OK”. 
Alternatively: 

1. Select “Rename” from the “Layout” menu on the Menu Bar.  
 

2. Type a new name in the displayed entry field. 
 

3. Click “OK”. 
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Insert a New Layout 

To insert a new layout to an existing project: 

1. Access the tab edit menu by right-clicking on a tab name. 
 

2. From the displayed menu, choose “Insert”.  
Alternatively: 

1. Select “Insert” from the “Layout” menu on the Menu Bar.  
 

Delete a Layout 

To delete a layout from an existing project: 

1. Access the tab edit menu by right-clicking on the tab name.  
 

2. From the displayed menu choose “Delete”. 
Alternatively: 

1. Select “Delete” from the “Layout” menu on the Menu Bar. 
 

Duplicate an Existing Layout 

To duplicate a layout in the current project: 

1. Access the tab edit menu by right-clicking on the tab name.  
 

2. From the displayed menu, choose “Duplicate”.  
 

3. Enter a name for the duplicated layout when requested. 
Alternatively: 

1. Select “Duplicate” from the “Layout” menu on the Menu Bar. 
 

2. Enter a name for the duplicated layout when requested. 
 

6.6  Change the Drawing Board Display 

Display the Grid 

To toggle the display of the grid: 

1. Click on “View” menu on the Menu Bar.  
 

2. Check the “Display Grid” option. 
Alternatively: 
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1. Access the drawing board edit menu by right-clicking on white space anywhere 
on the drawing board.  

 
2. Check the “Display Grid” option from the displayed items.  

 

Display the Unit Process Labels 

To toggle the display of the unit process labels: 

1. Click on “View” menu on the Menu Bar.  
 

1. Check the “Display Process Labels” option.  
Alternatively: 

1. Access the drawing board edit menu by right-clicking on white space anywhere 
on the drawing board.  
 

2. Check the “Display Process Labels” option from the displayed items. 
  

Display the Unit Process Connection Points 

To toggle the display of the unit process connection points: 

1. Click on “View” menu on the Menu Bar.   
 

2. Check the “Display Connection Points” option.  
Alternatively: 

1. Access the drawing board edit menu by right-clicking on white space anywhere 
on the drawing board.  

 
2. Check the “Display Connection Points” option from the displayed items.  

 

6.7  Customize Unit Processes 

Edit Parameters 

To edit the process parameters used for a given unit process: 

1. Access the unit process edit menu by right-clicking on the unit. 
 
2. Select “Edit <process name>“ from the displayed menu. The unit process dialog 

will be displayed. 
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3. Using the tabs to navigate through the various variables, locate and change the 

variables of interest. 
 

4. Click “Accept” to save the changes, or “Cancel” to discard any changes. 
 

Note: Users are advised to consult the Technical Reference or the on-line 
help for any explanations related to how particular parameters are used 
and/or defined.  

 

Note: To minimize the number of potential input errors, there is a suggested 
range for some process parameters. It is possible to enter a number 
outside of this range, but doing so will signal a warning message. 

 
 

 
 

 
To determine the suggested range, place the cursor over the entry field 
of interest. This will bring up a tool tip box that includes the default 
value for the parameter as well as the suggested range. 

 

Change Units 

To change the units of a particular parameter: 
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1. Click directly on the units that are to be changed. This will display a listing of 
possible units for that variable. 

 
2. Select the preferred units from the displayed listing.  
 

 
 

Note: There is a global setting for the units used which can be switched to SI 
or US units. See “Change Units” under “Set Preferences” in this “How 
to” section. 

 

Reset All Variables to the Default Settings 

To reset all or a portion of the parameter values and units on tabs of a dialog box: 

1. Click on “Layout” menu on the Menu Bar.  
 

2. Click the “Reset Inputs to Default Unit” button at the bottom of the dialog box.  
 

3. Click “Yes” to reset all variables:  
 

 
 

Reset One Variable to the Default Setting 

To reset an individual value back to its default setting: 

1.  Right-click on the entry field of the variable that is to be changed back to the 
default setting. 
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2. Click on the “Reset value to…” popup. The displayed variable will revert to the 
default setting without any further prompting. 

 

 

Access Help for a Particular Unit Process 

To access the help for a particular unit process: 

1. Select the “Help Contents” option under the “Help” menu. Selecting this option 
will open the help catalogue for this unit process. 
 

2. The help is scrollable and hyperlinks have been included to help navigation 
through the information. 
 

 
 

 

Add Personal Notes 

For every parameter, the user can make a note about why they might have changed 
a particular value from the default value. 
 

1. Click the “Notes” button ( ) beside the desired variable. Clicking this button 
will open another window with a text area that the user can type a note into. 
 

2. Click “Accept” to save the note. The button beside the variable will change its 

icon, ( ), to indicate that a note is present. Hovering the cursor over top of the 
button will pop up a tool tip that contains the note. 
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Override a Unit Process Design 

To override a unit process design: 

1. Access the unit process edit menu by right-clicking on it. 
 

 
 

2. Select “Edit <process name>“ from the displayed menu. The unit process dialog 
will be displayed. 
 

3. Click on the “Design Override” tab. 
 

4. Check the “Override Design” checkbox to gain access to the design parameter 
entry fields. 
 

5. Change all parameters that are to be overridden. 
 

6. Click “Accept” to save the changes. 
 

Note: After any changes to the design parameters, the layout must be re-
costed to incorporate those changes into the design. 
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Note: Users are advised to consult the Technical Reference for any 
explanations related to how a particular unit process is designed.  

Override Equipment Costs 

The costs for the equipment for each unit process are retrieved from a database and brought up-to-

date using several cost indices (see “Update the Cost Indices” in this “How to” section). The 

currently used database is display on the Toolbar, and can be changed using the drop-down box. 

 

To override the equipment costs for an individual unit process: 

1. Access the unit process edit menu by right-clicking on it. 
 

2. Select “Edit <process name>“ from the displayed menu. The unit process dialog 
will be displayed. 
 

3. Click on the “Equipment” tab. 
 

4. Check the “Override Database Costs” checkbox to gain access to the costing 
parameter entry fields. 

 

Unconstrained Design 
Values 

“Override Design” 

Checkbox 
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5. Edit the fields that need changing. 
 

6. Click “Accept” to save changes. 
 

Tip:  Users can access a tool tip for each equipment item by placing the 
cursor over the item of interest. The resulting pop-up tool tip gives a 
description of how the cost estimate was determined, what the base 
cost for the item is, and what index value was used to adjust the cost. 

 

 

Adjust Structural and Mechanical Life-Spans 

To adjust the life-spans of structural and mechanical components: 

1. Access the unit process edit menu by right-clicking on it. 
 

 
 

2. Select “Edit <process name>“ from the displayed menu. The unit process dialog 
will be displayed. 
 

3. Click on the “Replacement” tab. 
 

4. In the appropriate entry field, enter the expected life-span of the structural 
and/or mechanical components. 
 

5. Click “Accept” to save changes. 
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Override Overall Costs 

In the event that the overall costs for a certain unit process are already known and the CapdetWorks 

algorithms are not needed, the user can override the costs. To do this: 

1. Access the unit process edit menu by right-clicking on it. 
 

2. Select “Edit Cost Override Parameters” from the displayed menu. 
 

 
 

3. Select the checkbox beside the value the will be overridden and enter the value 
into the now-enabled text field. 

 

 
 
4. Click “Accept” to save changes and close the window. 

The Blower System Design 

The process blower system is designed by basing it on the total aeration requirement for the whole 

plant; hence, the blower system may not be exclusively associated with one unit process 

To edit the parameters of the blower system: 
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1. Select “Edit Blower System” from the “Model” menu on the Menu Bar. This will 
display the Blower System Parameter dialog window. 

 

 
 

2. Edit the parameters, override the design or equipment costs, and change the 
replacement schedule as needed. The procedure is similar to editing the 
parameters of the individual unit processes (see “Customize Unit Processes” in 
this “How to” section).  

 

 
 

Exclude Unit Processes from Cost Summary 

When designing an upgrade to a treatment plant, it is sometimes required to exclude some unit 

processes from the overall cost summary in order to view only the cost of the upgrade and not the 

cost of building the whole plant. To do this: 

1. Access the unit process edit menu by right-clicking on it. 
 

2. Unselect “Cost This Unit” from the displayed menu. An icon, ( ), will appear on 
the display of the unit process on the drawing board to indicate that the unit 
will not be costed. 
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3. Re-cost the layout. 
 

 
 

Manipulate Equipment Cost Databases 

To access the equipment cost database dialog window, select “Equipment Cost 
Database” from the “Cost Data” menu on the Menu Bar. 

 

 

View Available Databases 

CapdetWorks comes pre-installed with several databases. Most of the time, the 
most recent database will be used when creating a new layout, but the older ones 
are available for layouts that were created in the past. A user may also create their 
own database to account for local or updated costs (see “Create a New Database” in 
this “How to” section). 
 
The currently available databases can be viewed by selecting them from the drop-
down box at the top of the dialog window. The table will change its values to 
correspond to the current selection. 
 
The table contains four (4) columns.  
1. The description of the piece of equipment. 
2. The cost that was available when the database was created. 
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3. A display of which index is used to bring the value up to current day costs. 
4. The value of that cost index at the time that the database was created. 

Create a New Database 

1. Select “Equipment Cost Database” from the “Cost Data” menu on the Menu 
Bar. This will display the equipment cost database dialog window. 

2. Start by selecting the database that will be the starting point of the new 
database. Do this by choose the appropriate database from the drop-down box 
at the top of the window. 

 
 

3. Click the “Create new database” button ( ), and enter a name for the 
database when prompted. 

4. Click “OK”. A new database has now been added to the drop-down box, and the 
values in the table are editable. 

5. Click “Accept” to save the database and close the window, or follow the 
proceeding instructions to edit the newly created database. 

Edit a Database 

1. Select a database that will be changed using the drop-down box at the top of 
the window. 

 

Note: The databases that were pre-installed with CapdetWorks are not 
editable. Users wishing to edit one of these databases should first 
create a copy of the database (see above) and then edit this “new” 
database. 

 
2. Scroll (or use the “Find” feature) to locate the database entry that is to be 

changed. 
 
3. Double-click on the table cell to be changed (i.e. Cost, Cost Index or Value of 

Cost Index columns). 
 

 
 

4. Type the corrected data into the cell. 
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5. Press the “Enter” key. 
 

6. Click “Accept” to save the changes and close the window. 
 

Tip: Depending on the resolution of your monitor, and the setup of this 
table, the column headings may not be fully readable. To change the 
width of a column, click on the column vertical border and drag the 
border horizontally to the desired width. 

 

Note: The “Value of Cost Index” column refers to the value of the specified 
Cost Index at the time the equipment quote was obtained.  
 
If a new estimate is obtained at some time in the future, then this new 
cost estimate should be entered into the database “Cost” column. At 
the same time, the value of the applicable cost index should be updated 
to reflect the current value of the index.  

 

Delete a Database 

To delete one of the user-defined equipment databases: 

1. Select “Equipment Cost Database” from the “Cost Data” menu on the Menu 
Bar. This will display the equipment cost database dialog window. 
 

2. Select the database that will be deleted using the drop-down box at the top of 
the window.  
 

3. Click the “Delete database” button ( ). 
 

4. Click “Accept” to save the changes and close the window. 

Export/Import a Database 

Exporting and/or importing a database can be used to make a backup copy of a user-defined 

database, or move a database from one computer to another. 

To export/import one of the user-defined equipment databases begin by selecting “Equipment Cost 

Database” from the “Cost Data” menu on the Menu Bar. This will display the equipment cost 

database dialog window. 

Export 

1. Select the database that will be exported using the drop-down box at the top of 
the window.  
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2. Click the “Export database” button ( ). 
 

3. Specify the file name and location for the exported database. 
 

4. Click “Save”. 

Import 

1. Click the “Import database” button ( ). 
 

2. Select the file that is the previously exported database. 
 

3. Click “Open”. 

Customize Unit Costs 

 “Unit Costs” are defined as normal non-equipment costs (see above for the procedure used to edit 

equipment costs) and includes such things as construction materials, labor, chemical, financial and 

other miscellaneous costs. “Unit Costs” does not include extraordinary site-specific costing issues as 

these are accounted for using the “Additional Site-Specific Costs” dialog (see below). 

To customize the unit costs: 

1. Select “Unit Costs” from the “Cost Data” menu on the Menu Bar. This will bring 
up the Unit Costs dialog. 
 

2. Using the tabs, navigate to the entry fields of interest and edit as required. 
 

3. Click “Accept” to save changes. 
 

 
 
 

Incorporate Additional Site-Specific Costing Issues 

To incorporate additional site-specific costing issues into the design: 

1. Select “Overrides for Site-Specific Costs” from the “Cost Data” menu on the 
Menu Bar. This will bring up the Additional Site-Specific Costs dialog. 
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2. There are algorithms to estimate the approximate costs of each of the items in 
this dialog window. By selecting the checkbox beside each item, a text field will 
become activated so that the estimates can be overridden with either a specific 
value, or zero (to exclude the item). 
 

3. Click “Accept” to save the changes.  
 

Note: Users are referred to the Technical Reference to determine the impact 
of these options on the calculated costs.  

 

 

 

Update the Costing Indices 

The costs for the equipment for the unit processes are retrieved from the equipment cost database 

and brought up-to-date using several cost indices. 

To update the costing indices to the current values: 

1. Select “Cost Indices” from the “Cost Data” menu on the Menu Bar. This will 
bring up the Cost Indices dialog. 
 

2. Dispending on the selected database, Edit the appropriate entry fields with the 
current values of: 

• Hydromantis Cost Indices (automatic updates available through the Update 
button) or  

• monthly in Engineering News Record (ENR) and Chemical Engineering (MAS, 
and PIPE); or, 

• the user-defined cost indices. 
 

3. Click “Accept” to save the changes.  
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6.8  Perform Sensitivity Analysis 

Analysis Setup 

To setup a sensitivity analysis: 

1. Access the Sensitivity Analysis window by selecting “Sensitivity Analysis” from 
the “Analysis” menu on the Menu Bar. 
 

2. Using the “Process” drop-down box, select the unit process around which the 
analysis should be made. 
 

3. Using the “Parameter” drop-down box, select the independent variable for the 
sensitivity analysis. 
 

4. Set the range for the independent variable by typing appropriate values into the 
“Low value” and “High value” entry fields. 
 

5. Specify the number of steps for the sensitivity analysis. 
 

 
 

 
 

6. Click on the “Run Analysis” button located below the graph. 
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Customize the Sensitivity Graph 

Rescale the Y-axis: 

To rescale the Y-axis: 

1. Use the directional buttons to the left of the Y-axis and:  

• Click on the “Up” arrow button to increase the scale; or, 

• Click on the “Down” arrow button to decrease the scale; or, 

• Click on the middle button to reset the scale to the default setting for this 
analysis. 

Alternatively: 
2. Right-click on the graph and choose from the options of “Zoom in”, “Zoom out” 

and “Auto Range”. 
 
 

               
  



CapdetWorks V4.0  2018 

 

6-104 | Hydromantis Environmental Software Solutions, Inc. 

 
 

Tip: Rescaling the Y-axis can bring into view different curves that may be too 
close to the X-axis to see using the default Y-axis scale. 

 

Rescale the X-axis 

To rescale the X-axis: 

1. Set the range for the independent variable by typing appropriate values into the 
“Low value” and “High value” range settings. 
 

2. Click “Run Analysis”. 
 
Alternatively: 

3. Right-click on the graph and choose from the options of “Zoom in”, “Zoom out” 
and “Auto Range”. 

 

 
 

Output the Sensitivity Graph To Clipboard 

To place an image of the graph onto the system’s clipboard in order to paste into another program 

(eg. Microsoft Word/Excel):  

1. Click on the “Copy image to clipboard” button ( ) found to the left of the 
graph and below the rescaling and legend buttons. 

6.9  Set Preferences 
 Access the Preferences dialog box, by choosing “Preferences” from the “View” drop-down menu 

found on the Menu Bar. 
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Significant Figures 

To change the number of significant figures used for input and output: 

1. Access the Preferences Display dialog box (“Preferences” from the “Views” 
drop-down menu). 
 

2. Using the two significant figure entry fields (“Significant digits in input values” 
and “Significant digits in output values”), specify the required number of 
significant figures to be used in the dialog boxes and in the output.  
 

3. Click “Accept” to save the changes and close the window. 
 

 
 

Change Units 

Variables can be displayed with U.S. Units, SI Units, or the default setting of Mixed Units. The 

program includes a unit conversion algorithm that automatically corrects any displayed value if the 

units are changed. Units can be changed globally and the values will be automatically changed in the 

appropriate dialog boxes.  

 

To change the basis for all units of all variables: 

1. Access the Preferences Display dialog box (“Preferences” from the “Views” 
drop-down menu). 
 

2. Using the two pull-down menu boxes (“Default input units” and “Default 
output units”), choose between U.S. Units, SI Units or Mixed Units (which is a 
combination of both U.S. and SI units). 
 

3. Click “Accept” to save the changes and close the window. 



CapdetWorks V4.0  2018 

 

6-106 | Hydromantis Environmental Software Solutions, Inc. 

 
 

Change Currency 

The default currency of CapdetWorks is U.S. dollars. Using the “Currency units” drop-down box in 
the “Preferences” dialog window, the currency can be changed to a number of pre-defined 
currencies. Customized currencies and their conversion rates can be added to this list by clicking the 
“Add/Edit” button ( ). 

Toggle the Highlight of User Altered Parameters 

To toggle the highlight of user altered parameters: 

1. Access the Preferences Display dialog box (“Preferences” from the “Views” 
drop-down menu). 

 
2. Check/uncheck the “Highlight modified values in input forms” checkbox. This 

option will modify the way variables are displayed, such that parameter values 
that are not the same as the defaults will be colored blue. 
 

3. Click “Accept” to save the changes and close the window. 
 

Change Stream Line Color 

Stream colors can be customized to the user’s preference. Differentiating the color of wastewater, 
sludge, and recycle streams can create a layout that is easy to comprehend.  
 

1. Access the Preferences Display dialog box (“Preferences” from the “Views” 
drop-down menu). 
 

2. Click on the color box besides “Connection path color-<stream type> and select 
a color. 
 

3. Click “Accept” to save the changes and close the window. 
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7. Process Reference 
7.1  Influent Wastewater 

The influent wastewater must be characterized based on estimates of key parameters. CapdetWorks 

primarily uses BOD5, soluble BOD5, suspended solids (SS), TKN and phosphorus, but other 

parameters are used in specific unit processes. The following table provides typical values for Weak, 

Medium and Strong wastewaters. 

Typical composition of untreated wastewater 

Contaminant Weak Medium Strong Units 

Suspended Solids 100 220 350 mg/L 

BOD5 110 220 400 mg/L 

COD 250 500 1000 mg/L 

TKN 20 40 85 mgN/L 

NH3 12 25 50 mgN/L 

Total 
Phosphorous 

4 8 15 mgP/L 

* the user should characterize their own influent. 

 

7.2  Influent Pump Station 
There are several locations in a sewage treatment facility that may require pumping. Pumping of the 

raw waste is often required. Other points in the treatment facility that might require pumping are 

prior to trickling filters, tertiary filters, carbon adsorption units, or any treatment process that 

creates relatively high head losses. Generally, two different pump types are used for raw waste 

pumping and other pumping in the treatment facility. For this reason the pumping has been divided 

into raw waste pumping and intermediate pumping.  

Pumping of raw sewage at the inlet of a treatment facility is often required to produce the head 

required for sewage to flow through the plant. This pumping is generally accomplished with 

relatively low-head pumps that are capable of passing large solids without damage to the pumps. 
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7.3  Screening 
Screening devices are used to remove large objects that otherwise may damage pumps and other 

equipment, obstruct pipelines, and interfere with the normal operation of the treatment facilities. 

Screens used in wastewater treatment facilities or in pumping stations are generally classified as 

fine screens or bar screens. 

Fine screens are those with openings of less than ¼ in. These screens have been used as a substitute 

for sedimentation tanks to remove suspended solids prior to biological treatment. However, few 

plants today use this concept of solids removal. Fine screens may be of the disk, drum or bar type.  

Bar screens are used mainly to protect pumps, valves, pipelines, and other devices from being 

damaged or clogged by large objects. Bar screens consist of vertical or inclined bars spaced at equal 

intervals (usually ¾ to 3 in.) across the channel where wastewater flows. These devices may be 

cleaned manually or mechanically. Bar screens with openings exceeding 2 ½ in. are termed 

trashracks. 

The quantity of screenings removed by bar screens depends on the size of the bar spacing. As the 

handling and disposal of screenings is one of the most unpleasant jobs in wastewater treatment, it is 

usually recommended that the quantity of screenings be kept at a minimum. Amounts of screenings 

from normal domestic wastes have been reported from 0.5 to 5 ft3/MGal(US) of wastewater 

treated. However, the advent of newer fine screening approaches with washing and compacting of 

the screenings is changing this situation. 

Design of bar screens is based mainly on average and peak wastewater flow. Normal design and 

operating parameters are usually presented in the manufacturer’s specifications. General 

characteristics of bar screens are shown below. 

7.4  Grit Removal 
This section combines two processes: screening and grit removal. This is because most of the cost 

information available combines these processes. The cost estimates are parametric for this same 

reason and because the costs for these processes are small in comparison with the entire facility. 

Inaccuracy in estimating the cost of the preliminary treatment would introduce only a small error in 

the total facility cost. 

Grit removal is classified as a protective or a preventive measure. The process does not contribute 

materially to the reduction in the pollutant load applied to the wastewater treatment facility. Grit 

chambers are designed to remove grit which may include sand, gravel, cinder, and other inorganic 

abrasive matter. Grit causes wear on pumps, fills pump sumps and sludge hoppers, clogs pipes and 

channels, and occupies valuable space in sludge digestion tanks. Grit removal, therefore, results in 

the reduction of maintenance costs of mechanical equipment and the elimination of operational 

difficulties caused by grit. Grit removal is recommended for small and large treatment facilities and 

for those served by combined and separate sewer systems. Bar screens are usually installed ahead 

of grit chambers to remove large objects. 
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Grit removal is normally accomplished by controlling velocity and settling time. The objective is to 

settle the grit particles while keeping the putrescible matter in suspension. Theoretically, it is 

desirable to remove all grit; however, experience indicates that removing 65-mesh grit, i.e. grit that 

is retained on a 65-mesh screen, provides sufficient protection to mechanical equipment and 

eliminates the majority of operational troubles caused by the grit. To remove 65-mesh grit with a 

minimum of putrescible matter, a flow-through velocity of 0.75-1.25 ft/s must be provided. 

The type of settling that normally takes place in a grit chamber is classified as discrete settling, as 

each particle retains its identity while settling at a constant rate. The design of such a chamber is 

usually based on an overflow rate. The settling velocity of the smallest particle to be completely 

removed should just exceed the overflow rate. Smaller particles are removed in proportion, 

according to the ratio of their settling velocities to the settling velocity of the smallest particle that 

is, theoretically, 100 percent removed. The overflow rates selected in the design of a grit chamber 

must, therefore, exceed the settling velocity of the 65-mesh particle. Grit settling velocities are 

summarized in the table below. 

Grit chambers may be classified as either horizontal flow or aerated. In the horizontal flow type, the 

velocity is controlled by the dimensions of the chamber or by the use of a proportional weir or a 

Parshall flume at the effluent end of the chamber. Aerated grit chambers consist of a spiral flow 

aeration tank with the spiral flow velocity controlled by the dimensions and the quantity of air 

supplied to the chamber. These chambers are very efficient and the grit will be washed and easy to 

handle. Typically, aerated grit chambers provide a detention time of 3 minutes at the maximum rate 

of flow. Mechanical grit removal equipment is usually recommended. 

In summary, the design of grit chambers depends on the type selected, type of grit removal 

equipment, specification of the selected grit removal equipment, and the quantity and quality of the 

grit to be handled. 

 

7.5  Microscreening 
Microscreening is a method of removing suspended solids from water utilizing a rotating drum 

covered with a screen having 20 to 40 micron openings. The water flows into the drum and out 

through the screen. As the drum rotates, backwash jets remove the collected solids from the screen. 

The dirty backwash which is about 3 to 5 percent of the applied flow is collected and returned to the 

front of the treatment plant. The wastewater application rate is about 5 to 10 gpm(US)/sqft of the 

submerged screen area. The rotational speed can be varied with the flow utilizing level detection 

equipment which will send a signal to a speed controller. The higher the flow, the faster the speed. 

Experience with wastewater indicates slime growth could be a problem. Another method employed 

is to periodically wash the screen with a hypochlorite solution. 
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7.6  Equalization 
Equalization is used to dampen variable waste flows so that the treatment facility receives a 

relatively constant flow. It has been shown that many treatment processes operate better if 

extreme fluctuations in hydraulic and organic loadings are eliminated. 

Equalization basins are usually aerated to prevent the settling of solids and to prevent anaerobic 

conditions developing. 

The equalization basin volume is based on the magnitude and frequency of the variations in 

hydraulic and organic load. The basin volume required for equalizing dry weather diurnal flows is 

calculated based on two-hourly flows for 24 consecutive hours. However, if the two-hourly flow 

data is not available, the desired volume of the basin must be input by the user. The program can be 

used for equalization of flows other than dry weather diurnal flows by inputting the required basin 

volume. 

 

7.7  Dissolved Air Flotation (DAF) 
Flotation is a solid-liquid separation process. Separation is induced by introducing fine gas bubbles 

(usually air) into the system. The gas-solid aggregate has an overall bulk density less than the density 

of the liquid; thus, these aggregates rise to the surface of the fluid. Once the solid particles have 

floated to the surface, they can be collected by a skimming operation. In wastewater treatment, 

flotation is used as a clarification process to remove suspended solids and as a thickening process to 

concentrate various types of sludge. However, the process generally is used for clarification of 

certain industrial wastes and for concentrating waste-activated sludge. 

Dissolved air flotation (DAF) involves air being dissolved in the wastewater under elevated pressures 

and later released at atmospheric pressure. The principal components of a dissolved air-pressure 

flotation system are a pressurizing pump, air injection facilities, a retention tank, a back pressure 

regulating device, and a flotation unit. The primary variables for flotation design are pressure, 

recycle ratio, feed solid concentration, detention period, air-to-solid ratio, use of polymers, and 

solids and hydraulic loadings. Optimum design parameters must be obtained from bench scale or 

pilot plant studies. Typical design parameters are listed in the “Solid Loading” table. CapdetWorks 

sizes a circular DAF system with a concrete structure. 

 

7.8  Primary Clarification 
Sedimentation in clarifiers is a solid-liquid separation process designed to remove the suspended 

particles in the raw or pretreated wastewater that are heavier than water. Sedimentation removes 

some grit, removes the settleable fraction of the suspended solids from raw waste in primary 

clarifiers, separates the biological floc from the mixed liquor in the final clarifier of a biological 

treatment system, separates the chemical floc from the supernatant in physical-chemical systems, 
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and concentrates the solids. Sedimentation may be classified into four categories depending on the 

characteristics of the suspension. 

Discrete Settling 

Suspended solids in this case are discrete particles which retain their identity, size, shape, and 

settling velocity during the settling process. The main factor influencing the efficiency of the process 

is the overflow rate expressed as gal(US)/(sqft·d). All particles with settling velocities greater than 

the design overflow rate will be removed. Particles with settling velocities less than the design 

overflow rate will be removed in proportion to the ratio of their settling velocities to the design 

overflow rate. This type of settling normally occurs in a grit chamber. 

Flocculant Settling 

In this type of settling, particles flocculate and agglomerate during settling with changes in size, 

shape, and density. The settling velocity increases as the particles grow larger. The settling 

characteristics of the flocculant suspension can be determined through laboratory settling tests. 

Efficiency of removal is influenced by both the overflow rate and detention time. Flocculant settling 

normally occurs in a primary clarifier. 

Zone Settling 

This type of settling normally occurs with activated sludge. Particles adhere to each other and settle 

as a blanket, forming a distinct solid-liquid interface at the top of the settling zone. Removal 

efficiency is influenced by mass loading, overflow rate, and detention time. Batch sedimentation 

tests are usually performed to evaluate these characteristics for industrial waste suspensions. 

Compression Settling 

In this case, the concentration of the suspension is so great that the particles rest on each other at 

the bottom of the sedimentation basin. This type of settling occurs in a sludge thickener. 

Primary Clarifier Design 

Primary clarifiers are normally used alone or in conjunction with biological waste treatment systems 

to remove the settleable solids and a fraction of the BOD, thereby reducing the load on the 

biological systems. If efficiently designed and operated, primary clarifiers can remove 50 to 65 

percent of the suspended solids and 25 to 35 percent of the BOD5. 

Primary clarifiers are usually keyed to the overflow rates gal(US)/(sqft·d) and detention times. 

Detention times of 2 to 3 hours, based on average flows, are typical. Surface loading rates usually 

depend on the characteristics of the suspension to be separated. Laboratory studies may be used to 

determine the optimum design parameters for a specific suspension. Typical values for various 

suspensions are reported in the table below. Many government standards recommend a surface 

loading not exceeding 600 gal(US)/(sqft·d) for small plants (1 MGD/US or less). The relationship 

between overflow rates, detention times, and tank depths are presented below. 
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Outlet design and arrangement have been reported to affect the efficiency of the primary clarifier. 

Weir loadings should not exceed 10,000 gpd/ft for small plants (1 MGD(US) or less) and 15,000 

gpd/ft for larger plants. 

Primary clarifiers, rectangular or circular, are usually cleaned mechanically. A minimum of two tanks 

are usually provided to allow for maintenance and repair work. 

The volume of sludge produced in primary settling tanks depends on several factors which include 

the characteristics of the raw waste, the design of the clarifier, the condition of the removed solids, 

and the period between sludge removals. Sludge should be removed continuously or at least once 

per shift (more frequently in hot weather) to avoid deterioration of the effluent quality. Specific 

gravities of several types of sludge are also shown below. 

 

7.9  Ion Exchange 
Ion exchange is the reversible interchange of ions between a solid ion-exchange medium and a 

solution. Ion exchange has been used extensively for the removal of hardness, and iron and 

manganese from groundwater supplies. In wastewater treatment, ion exchange has been used 

mainly for the treatment of industrial wastes. However, ion exchange has been evaluated for the 

removal of nitrogen and phosphorus from municipal wastes, although it is not commonly used. 

An ion-exchange system usually consists of the exchange resin (cation or anion natural or synthetic), 

with provisions made for regeneration and rinsing. The most commonly used regenerants include 

sulfuric acid and caustic soda. Prior to application to the ion-exchange bed, wastewater may be 

subjected to pretreatment to remove certain contaminants which may hinder the performance of 

the exchange bed. 

 

7.10 Neutralization 
Neutralization is a unit operation in which pH adjustment of acidic or alkaline wastewater takes 

place. Neutralization of such wastes is necessary prior to: 

• Biological waste treatment where the optimum pH for bacterial activity (pH 6.5-8.5) must be 
maintained 

• Chemical treatment to provide an optimum pH for the reaction 

• Discharge to the receiving streams 
 
 
Neutralization can be achieved with many methods and is applied mainly to the treatment of 

industrial wastes. Acidic wastes may be neutralized by reaction with caustic soda, lime, or by passing 

the wastewater through a limestone bed. Neutralization through limestone beds may be 

accomplished through upflow or downflow systems. A maximum acid concentration of 0.6 percent 

H2SO4 is suggested to avoid coating the limestone with nonreactive calcium sulfate and to prevent 
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excessive evolution of carbon dioxide, both of which limit complete neutralization. Higher hydraulic 

rates may be used for upflow beds as the products are swept out before precipitation. However, the 

disposal of exhausted limestone beds may be a serious drawback to this method of neutralization. 

Mixing acid wastes with lime slurries is an effective means of neutralization. Lime is relatively 

inexpensive and possesses a high neutralizing capacity. Hydrated lime may produce a handling 

problem as it has a tendency to arch or bridge over the outlet in storage bins and has poor flow 

characteristics. Both caustic soda and sodium carbonate are more powerful than lime, and the 

reaction products are soluble and do not increase the hardness of the receiving waters. 

Alkaline wastes can be neutralized with acid (mostly sulfuric or hydrochloric), with fuel gas 

containing 14 per cent carbon dioxide, or with bottled carbon dioxide. Carbon dioxide will form 

carbonic acid when dissolved in water which will neutralize alkaline wastes. The reaction is slow, but 

sufficient, if the desired pH is near 7 or 8. The use of acid to neutralize alkaline wastes is fairly 

common. The reaction rate is almost instantaneous. A titration curve of the alkaline waste 

neutralized with various amounts of acid is helpful to ascertain the quantities of acid required for 

neutralization. 

The selection of a pH control system may prove to be one of the most troublesome tasks facing the 

design engineer because of the following factors: 

• The relation between the amount of reagent and pH is nonlinear 

• The input pH can vary rapidly in a short time 

• The flow can change while the pH is changing, and the two are not related 

• The pH at neutrality is so sensitive to the addition of reagent that a slight excess can cause 
large deviations from the setpoint 

• Measurement of the pH can be affected by materials which coat the electrodes 

• The buffer capacity of the waste has a profound effect on the relation between reagent feed 
and pH and may not remain constant 

 

Several types of pH control schemes have been applied in waste neutralization systems, including 

manual control, open loop control, closed loop systems, combined open and closed loop systems, 

feedback control, and feed forward control. 

 

7.11 Carbon Adsorption 
Activated carbon, when contacted with water containing organic material, will remove these 

compounds selectively by a combination of adsorption of the less polar molecules, filtration of the 

larger particles, and partial deposition of colloidal material on the exterior surface of the activated 

carbon. Adsorption results from the forces of attraction between the surface of a particle and the 

soluble organic materials that contact the particle.  
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As a result of the activation process, activated carbon has numerous pores within each particle and 

hence a large surface area per unit weight, making it an efficient adsorptive material. It has long 

been used to remove taste and odor causing impurities from public water supplies. Activated carbon 

adsorption has been used in wastewater treatment as a tertiary process following conventional 

secondary treatment or as one of several unit processes comprising physical-chemical treatment. 

The most efficient and practical use of activated carbon in wastewater treatment has been in fixed 

beds of granular activated carbon. A typical adsorption system consists of several adsorption trains 

operated in parallel. Each train contains two adsorbers arranged for series flow. The wastewater is 

applied to the adsorbers at a flow rate ranging from 4 to 8 gpm(US)/sqft. Contact time (empty bed 

residence time) ranges from 15 to 35 minutes depending on the desired effluent quality. 

To ensure minimum suspended solids collection in the adsorbers which can clog the pores and 

reduce adsorber capacity, the carbon adsorption system should be preceded by filtration. Provisions 

must be made to regularly backwash the adsorption system to flush out accumulated suspended 

solids and biological growth. One design practice is to allow for a bed expansion from 10 to 15 per 

cent. Flow rates during backwash should range from 10 to 15 gpm(US)/sqft. Biological growth can be 

controlled effectively by chlorination of the influent to the adsorber or by chlorination during the 

backwash operation. 

When the active sites on the carbon particles have been filled, the effluent quality deteriorates and 

the carbon must be regenerated or replaced. For systems requiring regeneration of less than 400 

pounds of carbon per day, it is not economical to have on-site regeneration. For larger systems, a 

regeneration system should be provided. A typical regeneration system would include a) hydraulic 

transport of the carbon to the regeneration unit, b) dewatering of spent carbon, c) heating of carbon 

to oxidize or volatilize the adsorbed impurities, d) water cooling of the carbon, e) water washing and 

hydraulic transport back to the adsorbers, and f) scrubbing of furnace off-gasses. The most common 

type of furnace in use is the multiple hearth furnace. 

 

7.12 Two-Stage Lime Treatment 
Two-stage treatment systems are used for phosphorus removal from wastewater. In principle, for a 

two-stage system, lime is added to the wastewater in the first stage to raise the pH above 11. At this 

pH, precipitation of hydroxyapatite, calcium carbonate, and magnesium hydroxide takes place. 

Carbon dioxide recarbonation is then added following the first-stage clarifier to reduce the pH to 9.5 

to 10, where calcium carbonate precipitation results. The sludge, which is mainly CaCO3 is then 

separated in a clarifier and the pH of the wastewater is adjusted to about 7 for further treatment or 

final disposal. CapdetWorks designs a two-stage lime treatment system as a combination of (1) 

chemical coagulation-precipitation basin using lime as a coagulate; (2) a primary recarbonation 

stage; (3) a clarifier designed as a primary clarifier; and (4) a secondary recarbonation stage. 
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7.13 Coagulation 
Chemical coagulation involves the aggregation of small particles into large, more readily settleable 

conglomerates. Chemical coagulation is a process used in water treatment for the removal of 

turbidity and color. In wastewater treatment, chemical coagulation has been used to remove 

colloidal and suspended matter from raw wastes, remove phosphorus, remove algae from oxidation 

pond effluents, and enhance sludge dewaterability. 

Wastewater can be coagulated using any of the coagulants common for water treatment. The most 

widely used chemicals include: iron salts (ferric chloride, ferric sulfate, ferrous chloride, and ferrous 

sulfate), aluminum salts (alum and sodium aluminate), lime and synthetic polymers. The choice of 

chemicals should be based on careful evaluation of the wastewater characteristics, availability and 

cost of the coagulant, and sludge handling and disposal characteristics. Jar tests must be conducted 

to determine the coagulant dosage, the optimum conditions for coagulation, the quality of the 

effluent, and the characteristics of the chemical sludge. 

Rapid mixing, flocculation and sedimentation are the major processes involved in the unit process of 

chemical coagulation. These steps may be accomplished in separate basins or in the integrated 

flocculator-clarifier type of unit. CapdetWorks only utilizes the circular integrated mixing chamber-

flocculator-clarifier type system. Chemical coagulation may be used as a part of a physical-chemical 

treatment system or for phosphorus removal from wastewaters. 

 

7.14 Recarbonation 
Recarbonation is a unit process that is used in lime-softening water treatment plants. In water 

treatment, recarbonation is usually practiced ahead of the filters to prevent calcium carbonate 

deposition on the grains which will result in shortening of the filter runs. Recarbonation is used to 

lower the pH of the lime-treated water to the point of calcium carbonate stability to avoid 

deposition of calcium carbonate in pipelines. 

With the use of lime treatment, recarbonation has been used in wastewater treatment. 

Recarbonation, in wastewater treatment, is mainly used to adjust the pH following lime treatment 

for such applications as phosphorus removal, ammonia stripping, or chemical clarification. 

Recarbonation may be practiced as either a two-stage or a single-stage system. Two-stage 

recarbonation consists of two separate treatment steps. In the first stage, sufficient carbon dioxide 

is added in the primary recarbonation stage to lower the pH of the wastewater to 9.3, which is near 

the minimum solubility of calcium carbonate. The sludge produced, which is mainly calcium 

carbonate, is then removed through settling and recalcined if recovery of the lime is desired. The 

time required to complete the reaction is normally 15 to 30 minutes. In the second stage, carbon 

dioxide is added to lower the pH to 7. It is possible, however, to add sufficient carbon dioxide to 

lower the pH from 11 to 7 in a single stage. Single-stage recarbonation eliminates the need for an 
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intermediate settling basin which is needed in the two-stage system. However, single-step 

recarbonation normally results in an increase in the calcium hardness of the water. 

 

7.15 Lagoon 
Lagoons have been extensively used for municipal and industrial wastewater treatment where 

sufficient land area is available. Some of the reasons for the popularity of lagoons are operational 

stability with fluctuating loads, usually require relatively unskilled operators, low O&M costs, and 

low construction costs. 

 

7.16 Aerated Lagoon 

Aerated Aerobic Lagoon 

The contents of an aerobic aerated lagoon must be completely mixed so that the incoming solids 

and the biological solids produced in the lagoon do not settle. Effluent quality is a function of 

detention time and will normally have a BOD ranging from one-third to one-half of the influent 

value. This BOD is due to the endogenous respiration of the biological solids escaping in the effluent. 

Before the effluent is discharged, the solids may be removed by settling. 

Aerated Facultative Lagoon 

The contents of this type of lagoon are not completely mixed. Thus, portions of the incoming solids 

and the biologically produced solids settle out and undergo anaerobic decomposition. As a result, 

the effluent from the facultative lagoon would contain higher soluble BOD concentration than from 

the aerobic one. 

Algal growth is possible, due to incomplete mixing. Effluent suspended solids can be very high 

depending on the season, temperature and mixing intensity in the lagoon. 

 

7.17 Complete Mix Activated Sludge 
A complete mix activated sludge is achieved when the oxygen uptake rate is uniform throughout all 

parts of the aeration tank and when sufficient mixing is provided to maintain the solids in the 

aeration tank in suspension.  

Organic loading and oxygen demand are uniform throughout the aeration tank, and mechanical or 

diffused aeration is used to completely mix the mixed liquor. 
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7.18 Plug Flow Activated Sludge 
The plug flow activated sludge process uses an aeration tank, a settling tank, and a sludge return line 

to treat wastewater. Wastewater and returned sludge from the secondary clarifier enter the head of 

the aeration tank to undergo a specified period of aeration. Diffused or mechanical aeration is used 

to provide the necessary oxygen and adequate mixing of the influent waste and recycled sludge. 

Absorption, flocculation, and synthesis of the organic matter take place during aeration. The mixed 

liquor (sludge floc plus liquid in the aeration tank) is settled in the secondary clarifier, and sludge is 

returned at a sufficient rate. 

 

7.19 SRT-Based Plug Flow Activated Sludge 
The SRT-based plug flow activated sludge process uses an aeration tank, a settling tank, and a sludge 

return line to treat wastewater. Wastewater and returned sludge from the secondary clarifier enter 

the head of the aeration tank to undergo a specified period of aeration. Diffused aeration is used to 

provide the necessary oxygen and adequate mixing of the influent waste and recycled sludge. 

Absorption, flocculation, and synthesis of the organic matter take place during aeration. The mixed 

liquor (sludge floc plus liquid in the aeration tank) is settled in the secondary clarifier, and sludge is 

returned at a sufficient rate. 

This object is similar to the plug flow activated sludge process, but this SRT-based algorithm is simply 

another approach. This algorithm is based on a University of Cape Town algorithm and is consistent 

with the idea of influent fractionation to more accurately predict the mass of solids that will be 

present in the tank. This approach is also consistent with the dynamic wastewater treatment model 

known as ASM1 (Henze et al. 1986) published as an International Water Association Scientific and 

Technical Report. This object is recommended for those who hope to export the final design to GPS-

X, Hydromantis’ dynamic process simulator, and perform further dynamic analysis of the design. 

 

7.20 Contact Stabilization Activated Sludge 
The contact stabilization process is defined as a modification of the activated sludge process in 

which raw wastewater is aerated with a high concentration of activated sludge for a short time 

period, usually less than 60 minutes to obtain BOD removal by adsorption. The solids are 

subsequently removed by sedimentation and transferred to a stabilization tank where aeration is 

continued to oxidize and condition the solids before they are mixed again with the raw wastewater 

flow. 

Contact stabilization was developed to take advantage of the absorptive properties of the sludge 

floc. Contact stabilization achieves adsorption in the contact tank, and oxidation and synthesis of 

removed organics occur in a separate aeration tank. 
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The volume requirement for aeration is approximately one-half of that of a conventional plug-flow 

unit. Therefore, it is often possible to double the capacity of an existing plug-flow plant by re-piping 

or making changes in aeration equipment. 

 

7.21 Extended Aeration Activated Sludge 
The extended aeration process is defined as a modification of the activated sludge process which 

provides for high solids retention time (SRT) within the aeration system. The concept envisages the 

stabilization of organic matter under aerobic conditions and disposal of the end products into the air 

as gases and with the plant effluent as finely divided suspended matter and soluble matter. The 

process requires a relatively low F/M ratio and long detention time. In the process, the aeration 

detention time is determined by the time required to oxidize the solids produced by synthesis from 

the BOD removed. The accumulation of volatile solids is very low and approaches the theoretical 

minimum; however, since some of the biological solids are inert, an accumulation of solids occurs in 

the system. 

 

7.22 High Rate Activated Sludge 
Modified or high-rate aeration activated sludge is defined as a modification of the activated sludge 

process in which a shortened period of aeration is used with a reduced quantity of suspended solids 

in the mixer liquor. The difference in the process design parameters (shorter detention time and 

lower mixed liquid suspended solids) results in less air requirement and, hence, less power 

consumption. Modified aeration is also characterized by a poor settling sludge and low BOD removal 

efficiencies. 

 

7.23 Oxidation Ditch 
The oxidation ditch is a variation of the extended aeration process. The typical oxidation ditch is 

equipped with aeration rotors or brushes that provide aeration and circulation. The sewage moves 

through the ditch at 1 to 2 ft/s. The ditch may be designed for continuous or intermittent operation 

and so may be adaptable to the fluctuations in flows and loadings. 

 

7.24 Step Aeration Activated Sludge 
Step aeration is defined as a procedure for adding increments of settled wastewater along the line 

of flow in the aeration tanks of an activated sludge plant. It is a modification of the activated sludge 

process in which an attempt is made to equalize the food-to-microorganisms ratio (F/M). Baffles are 

used to split the aeration tank into four (or more) channels. Each of these channels is a separate 

step and all channels are linked together in series. 
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Flexibility of operation is a prime factor to consider in the design of the process. The oxygen demand 

is essentially uniform over the length of the basin, resulting in more efficient utilization of the 

oxygen supplied. Introduction of influent waste at multiple locations allows this process to remove 

soluble organics within a relatively short contact time. This process is characterized by a higher 

volumetric loading than conventional plug flow activated sludge process. 

 

7.25 Pure Oxygen Activated Sludge 
The pure oxygen system may be used for aeration in activated sludge systems that operate in either 

the plug flow or complete mix hydraulic regimes. It is adaptable to new or existing complete mix 

systems and can be used to upgrade and extend the life of overloaded plug-flow systems. To use the 

pure oxygen system, the aeration tanks must be covered and the oxygen introduced should be 

recirculated. The amount of oxygen that can be injected into the liquid (for a specific set of 

conditions) is approximately four times the amount that could be injected with an air system. 

Adjustment of pH may be necessary to maintain a proper balance between the CO2 removed and 

buffer capacity of the wastewater. 

 
Several advantages, such as increased bacterial activity, reduced aeration tank volume, decreased 

sludge volume, and better settling sludge have been cited for pure oxygen aeration.  

 

7.26 Sequencing Batch Reactor 
This object is similar to the SRT-based plug flow activated sludge process in that it is based on a 

University of Cape Town plug flow tank algorithm and is consistent with the idea of influent 

fractionation to more accurately predict the mass of solids that will be present in the tank. The 

algorithm for the Sequencing Batch Reactor (SBR) has been developed based on the premise that 

where plug flow tanks are designed in space (i.e. reactors of a certain volume with a certain 

hydraulic retention time), SBRs are designed in time (i.e. aerobic cycle time). Nevertheless, the 

biology of the two approaches is assumed to be the same and hence the mass of solids generated is 

expected to be similar. This approach is also consistent with the dynamic wastewater treatment 

model known as ASM1 (Henze et al. 1986) published as an International Water Association Scientific 

and Technical Report. This object is recommended for those who hope to export the final design to 

GPS-X, Hydromantis’ dynamic process simulator, and perform further dynamic analysis of the 

design. 
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7.27 Trickling Filter 
Trickling filters are classified as low- or high-rate filters, depending on the hydraulic loading (1 to 4 

MGD(US) for low, 10 to 40 MGD(US) for high). In the trickling filtration process, a flow distributor 

distributes wastewater uniformly over the filter media. The majority of units use a reaction drive 

rotary distributor. A large portion of the wastewater rapidly passes through the filter; the remainder 

slowly trickles over the slime layer formed on the filter surface. BOD removal is achieved by 

biosorption and coagulation from the rapidly moving portion of the flow and by progressive removal 

of soluble constituents from the more slowly moving portion of the flow. 

The quantity of biological slime produced is controlled by the available food; the growth will 

increase as the organic load increases until a minimum effective thickness is reached. The maximum 

growth is controlled by physical factors including hydraulic dosage rate, type of media, type of 

organic matter, amount of essential nutrients present, oxygen transfer, and nature of the particular 

biological growth. 

The use of synthetic media has increased the popularity and the capability of trickling filters in 

domestic wastewater treatment. The granite stone medium is less frequently used in modern 

sewage treatment systems due to its higher capital costs and other limitations. Thus only the 

synthetic medium filter tower is designed in CapdetWorks. 

 

7.28 Rotating Biological Contactor 
The rotating biological contactor (RBC) system consists of a series of plastic discs mounted on a 

shaft. These discs are partially submerged in the wastewater and slowly rotated, thus exposing them 

alternately to air and wastewater. The discs act as supporting media for the biological growth which 

aerobically treats the wastes. Growth thickness is controlled by the shear forces produced by the 

water acting on the rotating discs. Covering the shafts is necessary to prevent sun-induced algae 

growth as well as to prevent freezing in colder climates. RBC shafts are available in lengths of from 

10 to 25 ft and support from 40,000 to 150,000 sqft of media per shaft. In order to simplify the 

design procedure, a shaft of 100,000 square feet of surface area is used in this section. 

The main advantages the RBC has over activated sludge and trickling filters are reduced land 

requirements and lower power consumption.  

RBC is applicable to both carbonaceous BOD5 removal and nitrification; however, this design 

procedure applies only to BOD5 removal. 

Developments in RBC drives, such as air drive system, are available from some manufacturers; 

however, only mechanical drives are considered here to represent a cross section of available units. 
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7.29 Moving Bed Biofilm Reactor (MBBR) 
The Moving Bed Biofilm Reactor (MBBR) is a biological wastewater treatment process which uses 

small polyethylene carriers to immobilize microorganism. The specific surface area of the media 

used in MBBR reactors could range from 100 m2/m3 to 1200 m2/m3. The volumetric fill fraction of 

the media is typically from 40 to 60%. The floating media is lighter than the water and has specific 

density of about 0.96 g/cm3. A screen is used at the outlet to prevent the escape of media from the 

tank. The media is kept in suspension through carefully designed mixing devices.  

A clarifier is typically used to separate the detached biomass from the MBBR reactor. In typical 

MBBR applications, it is common practice to not recycle the sludge from the secondary clarifier. The 

main advantage of MBBR technology is in reducing the solid loading on the secondary clarifier. As 

most of the biomass is attached to the media, the process is expected to be more robust to 

hydraulic and organic loadings.  

The MBBR process implemented in CapdetWorks can be used for BOD removal and nitrifications. In 

the costing of the unit process, the additional costs of media and separation screen are considered. 

7.30 Integrated Fixed Film Activated Sludge (IFAS) 
The Integrated Fixed Film Activated Sludge (IFAS) is a biological wastewater treatment process 

which a fixed film media is suspended in the activated sludge. The biological reactions are 

contributed by both the suspended and the fixed film biomass. The specific surface area of the 

media used in IFAS reactors could range from 100 m2/m3 to 1200 m2/m3. The volumetric fill fraction 

of the media is typically from 40 to 60%.  

A clarifier is typically used to separate the detached biomass from the IFAS reactor. One main 

difference between the MBBR and IFAS reactor is with respect to presence of a sludge recycle from 

the secondary clarifier to IFAS reactor. The main advantage of IFAS technology is in reducing the 

solid loading on the secondary clarifier. As most of the biomass is attached to the media, the process 

is expected to be more robust to hydraulic and organic loadings. IFAS finds applications in plants 

where extra treatment capacities are required for the existing tankage.  

The IFAS process implemented in CapdetWorks can be used for BOD removal and nitrifications. In 

the costing of the unit process, the additional costs of media and separation screen are considered. 

7.31 Membrane Bio-Reactor 
Biological treatment processes in which membrane filtration is used as a solid-liquid process instead 

of traditional secondary clarifier are categorized as membrane bioreactor. The membrane 

bioreactor based system can be operated at significantly higher MLSS concentration as compared to 

conventional activated sludge process.   This leads to reducing the foot-print of the treatment plant. 

The membrane bioreactors can produce effluent of much higher quality and could be a valuable 

technical proposition where effluent reuse options are available. The MBR reactors requires 

provisions of  filtrations membranes and associated coarse bubble scouring air arrangements to 

control membrane fouling. The membrane also needs physical and chemical cleaning at regular 
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interval for smooth operation of the plant. The cost of membrane and additional membrane 

cleaning requirements usually makes this treatment alternative more expensive than the 

conventional technologies. 

7.32 Nitrification 
Nitrogen in wastewater exists in several forms including organic nitrogen, ammonia nitrogen, nitrite 

nitrogen and nitrate nitrogen. The prevalent forms in untreated sewage are organic nitrogen and 

ammonia nitrogen. Organic nitrogen exists in both soluble and particulate forms. 

Nitrification is the process which converts organic and ammonia nitrogen to nitrate nitrogen. 

Nitrification may be coupled with denitrification, which reduces nitrate to nitrogen gas and removes 

the nitrogen from the water. 

Conversion of ammonia nitrogen in wastewater to nitrates or atmospheric nitrogen is desirable for 

several reasons:  

1. Nitrogen is one of the growth limiting nutrients. Control of nitrogen in 

wastewater effluents will help to limit the growth of algae and will slow the 

eutrophication process in the receiving water body.  

2. Ammonia nitrogen in the un-ionized molecular form (NH3) is toxic to fish.  

3. Biological oxidation of ammonia to nitrate in the receiving water adds to the 

oxygen demand on the water.  

4. Chlorination of wastewater containing ammonia requires high dosages because 

the chlorine combines with the ammonia to form chloramines which are less 

effective disinfectants. 

Nitrification Reactions  

The most studied bacteria involved in the nitrification process are Nitrosomonas and Nitrobacter. 

These bacteria are classified as autotrophic organisms. They derive energy from the oxidation of 

inorganic nitrogen compounds rather than from organic compounds, and they use inorganic carbon 

(carbon dioxide) rather than organic carbon for synthesis. 

Nitrosomonas oxidizes ammonia to nitrite, and Nitrobacter oxidizes nitrite to nitrate. It is assumed 

that these bacteria utilize gaseous CO2 and produce free H. In actuality, these reactions take place in 

the aqueous carbonic acid system. The organisms utilize the dissolved form of carbon dioxide, 

carbonic acid (H2CO3), and produce free hydrogen ions (H+) which immediately combine with the 

bicarbonate ion (HCO3
-) to form carbonic acid. Nitrification tends to increase the H2CO3 in solution 

which lowers the pH of the water and may interfere with the nitrification reactions. 

Experiments have determined that approximately 7.14 mg/L alkalinity is destroyed per mg of 

ammonia nitrogen oxidized. Sufficient alkalinity in the form of HCO3
- must be present to maintain a 

favorable pH. Experiments have also shown that the aeration requirement for nitrification systems is 
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4.6 mg/L oxygen per mg ammonia nitrogen. Excess air should be provided for oxidation of other 

oxygen demanding materials in the wastewater. 

 

The yield of nitrifiers is very low. Thus, ordinarily, nitrifier sludge production is ignored in 

engineering calculations. 

Nitrification Systems 

Biological nitrification and carbon oxidation may be combined in conventional secondary treatment 

processes or they may be divided into separate stages.  

In a separate stage nitrification system the ratio of BOD5 to Total Kjeldahl Nitrogen (TKN) is less than 

3.0 as compared to 5.0 for a combined system. Separate stage nitrification may be carried out in 

three types of systems:  

1. Suspended growth activated sludge;  
2. Attached growth trickling filters; and  
3. Attached growth rotating biological contactors (RBC). 

 

Suspended Growth  

Suspended growth nitrification systems are similar in design to carbon oxidation activated sludge 

systems. The biological growth is suspended in an aeration basin. Mechanical or diffused aerators 

provide oxygen for nitrification and provide mixing that keeps the solids in suspension. The mixed 

liquor is clarified to remove suspended solids and concentrate the sludge for recycle. The solids 

retention time in a nitrification system is longer than that in a carbon oxidation system due to the 

slower growth rate of the nitrifiers compared to heterotrophic bacteria. 

The suspended growth system can be operated as a complete mix or plug flow system and may 

utilize either mechanical or diffused aeration. In CapdetWorks, only the plug flow system is 

addressed; however, both diffused and mechanical aeration are considered. This system is preferred 

due to its superior shock load dampening capacity. The design is based on solids retention time 

required for the desired level of nitrification.  

Nitrifying Trickling Filter 

In separate stage nitrification application, trickling filters can follow high rate trickling filters with 

intermediate clarification or an activated sludge process. The rate of nitrification is proportional to 

the surface area of the media exposed to the liquid being nitrified. Little biological film develops in 

separate stage nitrification trickling filter. Hence, a media of higher specific surface area can be used 

without plugging or ponding, which can be a problem in combined oxidation-nitrification trickling 

filters. Because of the small growth of solids on the media, clarification is not necessary. In this 

section, only the separate stage fixed film system is modeled in CapdetWorks; the influent BOD and 

suspended solids concentration are in the range of secondary effluent levels. 
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Nitrifying Rotating Biological Contactor 

The rotating biological contactor (RBC) is an attached growth nitrification system. The RBC process 

consists of a series of large diameter plastic disks that are mounted on a horizontal shaft and placed 

in a concrete tank. The disks are slowly rotated while approximately 40 percent of the surface area 

is immersed in the water to be treated. A layer of biomass grows on the surface of the disks. A thin 

film of water is picked up on the biomass and flows down as the RBC rotates, absorbing oxygen from 

the air. The disk units are normally housed to avoid temperature drops, prevent algae growth and 

protect the slime layer from rain or hail which can wash the slime layer off the disks. 

Special RBC media have been developed for nitrification. The minimal biomass that forms in a 

separate stage RBC allows 50 percent more surface area per standard shaft. As in trickling filter 

nitrification systems, the low growth rate of biological solids produces an effluent with a suspended 

solids concentration equal to the influent and eliminates the need for final clarification in separate 

stage RBC nitrification. 

 

7.33 Denitrification 
Discharge of ammonia nitrogen to a receiving stream causes depletion of the stream’s dissolved 

oxygen content as the ammonia nitrogen is oxidized to nitrate. In addition, ammonia nitrogen can 

adversely affect fish life under certain environmental conditions. As a result, many wastewater 

treatment plants employ nitrification to convert ammonia nitrogen to nitrate nitrogen prior to 

discharge. However, the nitrogen in nitrate is available as a nutrient for biological growth. Thus, the 

discharge of nitrate can contribute to biostimulation of surface waters, resulting in affects such as 

algal blooms and eutrophication. As a result, a denitrification system must be use at certain 

treatment plants. The biological process of denitrification involves the conversion of nitrate nitrogen 

to gaseous nitrogen. The gaseous product, primarily nitrogen gas, is not available for biological 

growth. 

Denitrification is a two-step biological process. Nitrate is converted to nitrite, which in turn is 

reduced to nitrogen gas. This two-step process is termed “dissimilation”. A broad range of bacteria, 

including Pseudomonas, Micrococcus, Achromobacter and Bacillus, can accomplish denitrification. 

These bacteria can use either nitrate or oxygen to oxidize organic material. As the use of oxygen is 

more energetically favorable than nitrate, denitrification must be conducted in the absence of 

oxygen (anoxic condition) to ensure that nitrate, rather than oxygen, is used in the oxidation of the 

organic material. 

For denitrification to occur, a carbon source must be available for oxidation. As the process typically 

occurs after carbonaceous material in the raw wastewater has been removed, an external carbon 

source may have to be added to the denitrification system. As methanol (CH3OH) is the carbon 

source most often used in practice, its use is incorporated in CapdetWorks. It is important that only 

sufficient methanol is added to the process in CapdetWorks. 
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The theoretical methanol requirement for nitrate reduction and cell synthesis is 2.47 mg methanol 

per mg nitrate nitrogen. However, additional methanol is needed to ensure the complete reduction 

of any nitrite present and the elimination of any remaining oxygen. These factors increase the 

required methanol dosage to a value of about 3 mg methanol per mg nitrate nitrogen. 

The effect of pH on denitrification must be examined. In the conversion of nitrate nitrogen to 

nitrogen gas, bicarbonate is produced. This reduces the carbonic acid concentration and increases 

the wastewater alkalinity. This increase is estimated to be 3.0 mg alkalinity (CaCO3) per mg nitrogen 

reduced. As a result, denitrification will tend to increase the pH. It has been determined that the 

highest denitrification rates occur in the pH range from 7.0 to 7.5. Denitrification rates are 

depressed below pH 6.0 and above pH 8.0. 

CapdetWorks can design both suspended and attached growth denitrification systems. A common 

assumption for both systems is that the influent to the process is a nitrified secondary effluent. 

Suspended Growth  

In the suspended growth system, the contents of the denitrification reactor must be kept mixed, but 

not aerated. Mixed liquor from the reactor must undergo clarification to produce a clear effluent. 

Because the nitrogen gas produced in the process often becomes attached to the biological solids, a 

nitrogen release step is included between the reactor and the sedimentation basin. The removal of 

the attached nitrogen gas bubbles can be performed either in aerated channels connecting the 

biological reactor to the sedimentation facilitates or in a separate tank in which the biological solids 

are aerated for a short period of time. 

Attached Growth 

Several different attached growth processes are available for denitrification. Most schemes use an 

upflow configuration with the media submerged. Reactors are classified as either packed bed or 

fluidized bed types. Packed bed media can be high-porosity plastic modules and dumped rings or 

low-porosity fine media. Fluidized bed units use high-porosity fine media. The designed system will 

be submerged, packed bed reactor filled with high porosity corrugated plastic sheet modules. 

 

7.34 Biological Nitrogen Removal 
The reader is referred to the denitrification section of this Process Reference chapter for a detailed 

description of Biological Nitrogen Removal. 

 

7.35 Biological Nutrient Removal 
Biological nutrient removal encompasses both denitrification (described previously) and excess 

biological phosphorus removal (EBPR) separately, or in combination. EBPR is a biologically mediated 

process used within activated sludge systems to achieve phosphorus removal from wastewater. The 

process involves cultivating within the mixed community, microorganisms (termed polyphosphate 
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accumulating organisms or PAOs) which have the ability to take up more phosphorus than they 

require for growth. The net effect of this uptake is a reduced wastewater concentration to a level of 

residual phosphorus which can be less than 1mg/L. 

Experience has shown that significant biological nutrient removal (BNR) activity does not occur in 

strictly aerobic systems. Rather, BNR behavior is achieved by incorporating an unaerated zone into 

the process design. For denitrification, an anoxic stage (nitrate present, no oxygen) is included and 

for EBPR, an anaerobic stage (neither nitrate nor oxygen present) must be included in the reactor 

configuration.  

Biological Nutrient Removal - 2-Stage 

This reactor configuration includes an anaerobic/unaerated stage ahead of an aerobic reactor. These 

reactors are followed by a secondary clarifier that is used to concentrate the sludge and return it to the 

unaerated stage. A treatment configuration with a membrane separator is also available for this process 

scheme.  

 

 

 

Biological Nutrient Removal - 3/5 Stage 

The 3-stage biological nutrient removal configuration includes an anaerobic stage, followed by an anoxic 

stage followed by an aerobic stage. One internal recycle is used to recycle nitrate from the aerobic stage 

to the anoxic stage and a return activated sludge (RAS) recycle is used to recycle thickened sludge from 

the clarifier to the anaerobic stage. A treatment configuration with a membrane separator is also 

available for this process scheme.  

 

 

 

The 5-stage configuration (also termed a “modified Bardenpho”) is similar to the 3-stage 

configuration in that the first three reactors are similar and one internal recycle recycles nitrate to 
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the anoxic stage. However, to increase the nutrient removal capacity, two additional stages are 

placed after the aerobic stage and before the clarifier. The first of these stages is anoxic for more 

denitrification, and the second is aerobic for effluent polishing. A treatment configuration with a 

membrane separator is also available for this process scheme.  

 

 

 

 

7.36 Intermediate Pumping 
There are several locations in a sewage treatment facility that may require pumping. Typically at the 

head of the treatment facility pumping of the raw waste is required. Other points in the treatment 

facility which might require pumping are prior to trickling filters, tertiary filters, carbon adsorption 

units, or any treatment process which creates relatively high head losses. Generally speaking two 

different type pumps are used for raw waste pumping and pumping for other processes in the 

treatment facility. For this reason the pumping has been divided into raw waste pumping and 

intermediate pumping. Raw wastewater pumping was previously discussed. 

In intermediate pumping the wastewater is relatively clean and free from large solids so that more 

efficient pumps can be used for these processes than for raw waste pumping. 

 

7.37 Rapid Infiltration Land Treatment 
Rapid infiltration treats the wastewater with a minimum of land area. Wastewater is applied to deep 

and permeable deposits such as sand or sandy loam usually by distributing in basins or infrequently 

by sprinkling, and is treated as it travels through the soil matrix by filtration, adsorption, ion 

exchange precipitation and microbial action. Vegetation is not usually used, but crops may be grown 

to help maintain infiltration rates; however, harvesting normally would not be an objective. A much 

greater portion of the applied wastewater percolates to the groundwater than with slow rate land 

treatment. An underdrain system may be incorporated into the system to recover the renovated 

water for reuse, to control groundwater mounding, or to minimize trespass of wastewater onto 

adjoining property by horizontal subsurface flow. There is little or no consumptive use by plants and 

less evaporation in proportion to a reduced surface area. A cycle of flooding and drying maintains 

the infiltration and treatment capacity. 
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Removal of wastewater constituents by filtering and straining action of the soil is excellent. 

Suspended solids, BOD, and fecal coliforms are almost completely removed in most cases. Removal 

of BOD is primarily accomplished by aerobic bacteria that depend on the resting period to reaerate 

the soil. BOD loading rates have some effect on removals but too many other variables such as 

temperature, resting period, and soil type are involved to allow estimation of removals from loading 

rate alone. 

Nitrogen removals are generally poor. The basic mechanisms for nitrogen removal include 

nitrification-denitrification and ammonium sorption. Denitrification may be enhanced through 

adjusting application cycles, supplying an additional carbon source, using vegetated basins, recycling 

of renovated water and reducing application rates. Rapid infiltration systems will produce a nitrified 

effluent at nitrogen loadings up to 60 lbs/acre-day. Nitrification below a temperature of 36 deg F 

and below a pH of 5 is minimal. 

Phosphorus removals can range from 70-99% depending on the physical and chemical 

characteristics of the soil. The primary removal mechanism is adsorption with some chemical 

precipitation. Consequently, long-term capacity is limited by the mass of the soil in contact with the 

wastewater in the soil and travel distance. 

Heavy metals are removed from solution by adsorptive process and by precipitation and ion 

exchange in the soil. The concern about heavy metals in rapid infiltration systems are related to the 

high rate of application and low adsorptive potential of coarse soils. Microorganism removal is 

accomplished through sedimentation, predation and desiccation prior to application, desiccation 

and radiation during application; and straining, desiccation, radiation, predation and hostile 

environmental factors upon application to the land 

Typical design criteria include field areas of 3 to 56 acre/MGD(US); application rates of 20 to 400 

ft/yr (4 to 92 in/week); BOD5 loading rates of 20 to 100 lb/acre-d; soil depth of 10 to 15 ft or more; 

soil permeability of 0.6 in/h or more; hydraulic loading cycle of 9 hours to 2 weeks application 

period followed by 15 hours to 2 weeks resting period; soil texture - sand, sandy loams; basin size of 

4 ft; underdrains of 6 or more ft deep, application techniques - flooding or sprinkling. 

Common pre-application treatment practices include: primary treatment for isolated locations with 

restricted public access; biological treatment for urban locations with controlled public access. 

Storage is sometimes provided for flow equalization and for non-operating periods. Environmental 

impacts include potential for contamination of groundwater by nitrites and nitrates. Heavy metals 

may be eliminated by pretreatment techniques as necessary. 

 

7.38 Overland Flow Land Treatment 
Land treatment of wastewater involves the use of plants, the soil surface and the soil matrix for 

wastewater treatment. Although there are some differences in the use and definition of terms, 

there are three principal processes of land treatment. The “slow rate process” (also called crop 
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irrigation) couples wastewater management with recycling of nutrients in crop production. “Rapid 

infiltration” (also known as infiltration/percolation) emphasizes water reclamation rather than direct 

nutrient recycling. The product water from rapid infiltration may be reused for crop production, 

returned to surface waters, or allowed to recharge groundwater. “Overland flow” also emphasizes 

water reclamation. Unlike rapid infiltration, the product water from overland flow is almost always 

discharged directly to surface waters. 

Selection of the appropriate land application method requires matching the management objectives 

and wastewater characteristics to the characteristics of potential sites, expected treatment 

efficiencies, and land requirements. Factors such as wastewater quality, climate, soil geology, 

topography, land availability and effluent quality requirements will determine which process is most 

suitable for a particular application. 

In overland flow land treatment, wastewater is applied over the upper reaches of sloped terraces 

and is treated as it flows across the vegetated surface to runoff collection ditches. The wastewater is 

renovated by physical, chemical and biological means as it flows in a thin film down the relatively 

impermeable slope. There is relatively little percolation involved either because of an impermeable 

soil or a subsurface barrier to percolation. 

The primary objective of overland flow is wastewater treatment. A secondary objective of the 

system is for crop production. Perennial grasses (Reed, Canary, Bermuda, Red Top, Tall Fescue and 

Italian Rye) with long growing seasons, high moisture tolerance and extensive root formation are 

best suited to overland flow. Harvested grass is suitable for cattle feed. 

Biological oxidation, sedimentation and grass filtration are the primary removal mechanisms for 

organics and suspended solids. Nitrogen removal is attributed mainly to nitrification/denitrification 

and plant uptake. Permanent nitrogen removal by plant uptake is only possible if the crop is 

harvested and removed from the field. Ammonia volatilization can be significant if the pH of the 

wastewater is above 7. Nitrogen removals normally range from 75 to 90% with runoff nitrogen being 

mostly in the nitrate form. Phosphorus is removed by adsorption, plant uptake and precipitation. 

Treatment efficiencies are somewhat limited because of the incomplete contact between the 

wastewater and the adsorption sites within the soil. Phosphorus removals usually range from 30 to 

60%. Increased removals may be accomplished through pre-application treatment with aluminum or 

iron salts. Trace elements removal is relatively good with removal efficiencies ranging from 90 to 

98%. 

Loading rates and cycles are designed to maintain active micro-organism growth on the soil surface. 

The operating principles are similar to a conventional trickling filter with intermittent dosing. The 

rate and length of application is controlled to minimize severe anaerobic conditions that result from 

overstressing the system. The resting period should be long enough to prevent surface ponding yet 

short enough to keep the microorganisms in an active state. Surface methods of distribution include 

the use of gated pipe or bubbling orifice. Slopes must be steep enough to prevent ponding of the 

runoff yet mild enough to prevent erosion and provide sufficient detention time for the wastewater 
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on the slopes. Slopes must also have a uniform cross slope and be free from gullies to prevent 

channeling and allow distribution over the surfaces. Storage must be provided for non-operating 

periods when air temperatures fall below freezing. Runoff is normally collected in open ditches. 

Typical design criteria include field area requirements of 35 to 100 acres/MGD(US); terraced slopes 

of 2 to 8 %; terrace lengths of 120 to 140 ft; application rate of 11 to 32 ft/yr (2.5 to 15 in/week); 

BOD5 loading rate of 5 to 50 lb/acre-d; soil depth must be sufficient to form slopes that are uniform 

and to maintain a vegetative cover; soil permeability of 0.2 in/h or less; hydraulic loading cycle of 6 

to 8 hours application period followed by 16 to 18 hours resting period; operating period of 5 to 6 

days/week; soil texture of clay or clay loams. 

Common pre-application treatment includes screening or comminution for isolated sites with no 

public access, screening or comminution plus aeration to control odors during storage or application 

for urban locations with no public access. Wastewater high in metal content should be pretreated to 

avoid soil and plant contamination. 

 

7.39 Slow Infiltration Land Treatment 
Slow rate infiltration is the most common method of treatment by land application. Wastewater is 

applied to vegetated soils that are slow to moderate in permeability (clay loams to sand loams) and 

is treated as it travels through the soil matrix by filtration, adsorption, ion exchange, precipitation, 

microbial action, and plant uptake. Part of the water is lost through evaporation and plant 

transpiration, part is stored in plant tissue, and the remainder either percolates to groundwater or is 

collected in an underdrainage system and reused. Surface runoff is generally negligible. 

Wastewater application techniques include sprinkling or surface distribution. Sprinklers can be 

categorized as hand moved, mechanically moved and permanent set, the selection of which includes 

the following considerations: field conditions (shape, slope, vegetation and soil type), climate, 

operating conditions, and economics. Surface distribution employs gravity flow from piping systems 

or open ditches to flood the application area with several inches of water. Application techniques 

include ridge and furrow and surface flooding (border strip flooding). Ridge and furrow irrigation 

consists of running irrigation streams along small channels (furrows) bordered by raised beds 

(ridges) upon which crops are grown. Surface flooding irrigation consists of directing a sheet flow of 

water along border strips or cultivated strips of land bordered by small levees. The latter method is 

suited to close-growing crops such as grasses that can tolerate periodic inundation at the ground 

surface. 

Organics are removed by biological oxidation within the top few inches of soil. Filtration and 

adsorption are the initial mechanisms in BOD removal but biological oxidation is the ultimate 

treatment mechanism. Suspended solids removals are not as well documented as BOD removal but 

concentrations of 1 mg/L or less can generally be expected in the renovated water. Filtration is the 
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major removal mechanism for suspended solids while volatile solids are biologically oxidized and 

fixed, or mineralized and become part of the soil matrix. 

Nitrogen is removed primarily by crop uptake, which varies with the type of crop grown and the 

crop yield. Nitrogen removal can also be partially accomplished through biological denitrification 

and volatilization. Losses due to denitrification have been reported to range from 15 % to 25 % of 

the applied nitrogen. To protect ground waters, the percolate nitrogen should be limited to 10 mg/L 

for design purposes. 

Phosphorus removal is effective as a result of soil adsorption, precipitation and crop uptake. Trace 

metals are removed from solution by adsorptive process and by precipitation and ion exchange in 

the soil. 

Vegetation is a vital part of a slow rate system and serves to extract nutrients, reduce erosion and 

maintain soil permeability. Considerations for crop selection include:  

1. Suitable to local climate and soil conditions,  
2. Consumptive water use and water tolerance,  
3. Nutrient uptake and sensitivity to wastewater constituents,  
4. Economic value and marketability,  
5. Length of growing season,  
6. Ease of management, and  
7. Public health regulations.  
 

Typical design criteria include: field area 56 to 560 acres/MGD(US); application rate 2 to 20 ft./yr 

(0.5 to 4 in/wk); BOD5 loading rate 0.2 to 5 lb/acre-d; soil depths 2 to 3 ft. or more; soil permeability 

0.06 to 2.0 in/h; minimum pre-application treatment equivalent to primary; lower temperature limit 

25 deg F. 

Pre-application treatments include the following: primary treatment for isolated locations with 

restricted public access and when limited to crops not for direct human consumption; biological 

treatment plus control of coliform to 1000 MPN/ 100 mL for agricultural irrigation except for food 

crops be eaten raw; secondary treatment plus disinfection for public access areas (parks). 

Wastewater high in metal content must also be prevented to avoid soil and plant contamination. 

 

7.40 Secondary Clarifier 
For a general description of sedimentation, the reader is referred to the Primary Clarification section 

of this process reference chapter. 

The secondary or final clarifier performs a vital role in a secondary waste treatment system. In the 

activated sludge process, the final clarifier must provide an effluent low in suspended solids and an 

underflow of sufficient concentration to maintain a sufficient population of active microbial mass in 

the aeration tank. Final clarifiers are, therefore, designed to provide clarification, as well as 
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thickening. 

In addition to being governed by the overflow rate and detention time, the design of final clarifiers 

must be based on solid loading rate (lb solids/(sqft·d). Typical values of overflow rates 

recommended for the design of secondary clarifiers include 600 gal(US)/(sqft·d) for smaller plants 

(up to 1 MGD(US)), and up to 800 gal(US)/(sqft·d) for larger plants. The design calculation should 

consider the peak incoming wastewater flow; the return sludge withdrawal usually takes place at a 

point very near the inlet to the tank. Typical solids loading rates reported range from 12 to 30 

lb/(sqft·d). Solid concentration of the underflow ranges from 0.8 to 1.2 percent, by weight. 

The performance of the final clarifiers is affected by the method of sludge withdrawal. The preferred 

sludge collection mechanism is a vacuum- or suction-type draw off. The plow-type collectors with 

the chain and flight mechanism in rectangular basins or the bridge with attached plows in circular 

basins are also used. 

 

7.41 Post Aeration 
Many jurisdictions have established standards that require minimum levels of dissolved oxygen in 

the effluent from sewage treatment plants. To maintain this desired oxygen level, post-aeration is 

often used. Post-aeration may be accomplished by diffused or mechanical aeration in separate 

basins or by cascade aeration. 

 

7.42 Filtration 
Filtration is the removal of suspended solids through a porous medium. Filtration was used mainly in 

water treatment to remove suspended solids and bacteria. However, the increasing concern for 

abatement of water pollution and the requirements for high quality effluents from wastewater 

treatment facilities have resulted in the rapid, wide acceptance of filtration in wastewater 

treatment. Filtration is being used for the removal of biological floc from secondary effluents, 

phosphate precipitates from phosphate removal processes, and as a tertiary wastewater treatment 

operation to prepare effluents for reuse in water reuse, industry, agriculture, and recreation. 

Granular media used in filtration include sand, coal, crushed anthracite, diatomaceous earth, perlite, 

and powered activated carbon. Sand filters have been mostly used. These filters are classified into 

slow sand filters and rapid sand filters. 

Slow sand filters are normally 12 to 30 in. deep. The sand rests on a layer of gravel which, in turn, 

rests on an underdrain system. The filter is usually operated at a rate of 3 gal(US)/(sqft·h). When the 

filter becomes clogged, it is normally deactivated, drained, allowed to partially dry, and the surface 

layer of sludge is manually removed. Since slow sand filters require large space, have high 

maintenance costs, and clog rapidly, their application to water treatment has been abandoned; their 

application to wastewater treatment has been very limited. 
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Rapid sand filters consist of a layer of sand 18 to 30 in. thick supported by a layer of gravel 6 to 18 in. 

thick and an underdrain system. The underdrain system not only supports the sand, but also collects 

the filtered water and distributes the backwash water. The gravel aids in the distribution of the 

waste water while preventing the loss of filter media to the underdrain. Rapid sand filters are 

cleaned by backwashing. Normally, the filter is backwashed when the head loss increases to a value 

approaching the actual head available or when the effluent quality begins to deteriorate. The length 

of time of filter runs normally depends on the quality of the feed water. The common rate of 

backwashing is 24 to 30 in/min (about 15 gal(US)/(sqft·min) for 3 to 10 min. This rate results in 

about 30 percent expansion of the sand. 

Rapid sand filters are usually constructed in duplicate. The filters are commonly arranged in rows 

along one or both sides of a pipe gallery. Total depths of filters from water surface to underdrains 

range from 8 to 10 ft. A length-to-width ratio of the filter box of 3 to 6 has been found most 

economical. Wash water gutters must be located so that they limit the horizontal travel of dirty 

water during backwashing to 3 ft. As a safety factor, the top edge of the backwash gutter is normally 

located 6-12 in. above the allowed expansion of the sand (usually 50 percent). Backwash gutters 

must be designed to carry all backwash water with a minimum 3-in. free fall at the upper end. The 

underdrain system must be designed to carry the backwash water and to provide uniform 

distribution of backwash water. 

The removal of surface material by sand filters leaves a heavy residue of removed solids on the raw 

water side of the filter medium. Surface filtration is extremely sensitive to suspended solids 

concentration in the feed water. Sand filters may quickly become clogged at the surface, resulting in 

an extremely short filter run, thereby limiting the practical application of sand filters in wastewater 

treatment. 

One method used to increase the effective depth of filtration involves the use of dual-media or 

multimedia beds. The filters are composed of two or three materials of different specific gravities 

and sizes. The coarsest and lightest materials are placed on top; the finest and heaviest materials 

are on the bottom. An anthracite/sand filter is an example of a dual-media filter. Typical 

anthracite/sand filters may include from 12 to 24 in. of anthracite (specific gravity, 1.4 to 1.6) and 6 

to 16 in. of sand (specific gravity, 2.65). Multimedia filters normally consist of anthracite placed on 

top of sand which is placed on top of garnet. 

Another innovation introduced into filtration is the mixed media concept. For this process, the size 

distribution of the different media is selected to ensure intermixing between the various media at 

the interfaces. This mixing will prevent the formation of an impervious layer of the interface during 

filtration. A typical mixed multi-media filter may consist of 12 in. of sand with an effective size of 

0.5-.055 mm and a uniformity coefficient of less than 1.65, and 12 in. of crushed anthracite coal with 

an effective size of 0.9-1.0 mm and a uniformity coefficient of less than 1.8. A typical mixed 

multimedia filter has a particle size gradation that decreases from about 2mm anthracite at the top 

to about 0.15mm garnet at the bottom. 
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A mixed-media design typically used for removal of moderate quantities of chemical floc requires a 

backwash rate of about 15 gpm(US)/sqft. The head loss through the expanded filter is 2-4 ft. The 

required duration for backwash water is typically 2 to 5 per cent of the plant throughout. Surface 

wash is also necessary to break up the clumps. Normally, surface wash is initiated 1 min before the 

main backwash starts and is stopped about 1 min prior to the end of the backwash. 

In summary, the design of filters depends on the influent wastewater characteristics, process and 

hydraulic loadings, method and intensity of cleaning, nature, size, and depth of the filtering 

material, and the required quality of the final effluent. In general, mixed dual media and multimedia 

filters are more effective and easier and less expensive to operate than sand filters for the 

treatment of wastewaters; therefore, they are more widely accepted in wastewater treatment. 

The design of a tertiary filtration system involves using pilot study data or rules-of-thumb to 

calculate the required filter surface area and select the appropriate off-the-shelf units available from 

various manufacturers. The filtration manufacturers usually provide customers with all necessary 

equipment except pumps, concrete structure, and housing. The filter media, backwash trough, and 

underdrain system are specified by the manufacturers. The consulting engineers have to select the 

appropriate model from the manufacturers and design the concrete and associated structures. 

There are various sizes and types of filtration units available in the market. For smaller installations, 

the package units usually are selected. They are completely self-contained filter units to be shipped 

from the factories preassembled. The general contractors have to provide the concrete slabs and 

influent-effluent piping system. For larger installations, concrete wall constructions are used for 

containing the filter units. The filter manufacturers supply the media, backwashing troughs, control 

systems, underdrain, etc., which are installed in the field by the general contractor. Thus, the 

designs of these two types of filters are different and should be treated separately. Each 

manufacturer specifies his/her own filter configurations, dimensions and other requirements. These 

requirements are often proprietary. These diversifications make generalized computer modeling 

difficult, especially when package units are used. Thus a parametric cost curve is used for the 

package type filtration units. The construction cost for the larger concrete wall rectangular cell 

filtration systems are estimated based on equipment and material costs. 

Because tertiary filters are usually at the end of treatment processing trains and large head losses 

are expected, intermediate pumping is often required to deliver the main stream to the filter units. 

However, information on the main stream pumping facility is not included in this section; rather, 

design and cost data are presented in the section entitled “intermediate pumping station”. 

 

7.43 User Wastewater Process 
The user has control over all available parameters. 
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7.44 Chlorination 
Disinfection is the selective destruction of pathogenic organisms; sterilization is the complete 

destruction of all microorganisms. Disinfection may be considered as one of the most important 

processes in wastewater treatment. This practice, used in water and wastewater treatment, has 

resulted in the control and reduction of waterborne diseases. 

Disinfection may be accomplished through the use of chemical agents, physical agents, mechanical 

means, and radiation. In wastewater treatment the most commonly used disinfectant is chlorine; 

however, other halogens, ozone, and ultraviolet radiation have been used.  

The most common forms of chlorine used in wastewater treatment plants are calcium and sodium 

hypochlorites and chlorine gas. Hypochlorites are recommended for small treatment plants where 

simplicity and safety are more important than cost. Chlorine gas may be applied as a gas, or mixed 

with water to form a solution. Chlorine gas is the only chemical disinfection method considered in 

CapdetWorks. 

The rate of disinfection by chlorine depends on several factors, including chlorine dosage, contact 

time, presence of organic matter, pH, and temperature. The recommended chlorine dosage for 

disinfection purposes is that which produces a chlorine residual of 0.5 to 1 mg/L after a specified 

contact time. Effective contact time of not less than 15 minutes at peak flow is recommended. 

Typical chlorine dosages recommended for disinfection and odor control are presented in the 

following table. 

The design of the chlorine contact tank plays an important role in the degree of effectiveness 

produced from chlorination. Factors that must be considered in the design include method of 

chlorine addition, degree of mixing, minimization of short circuiting, and elimination of solids 

settling.  

 

7.45 Ultra-Violet Disinfection 
Ultra-Violet Disinfection has been used to disinfect wastewater for some time and is often the 

preferred disinfection method. UV disinfection has the following advantages over chemical 

methods: 

• No residual toxicity 

• More effective than chlorine in inactivating viruses, spores, cysts 

• Improved safety 

• No chlorinated byproducts 
 

The major disadvantage is cost, although this is improving as additional technology is brought to 

market. In addition, the ultra-violet sources must be cleaned regularly to maintain effective 

disinfection. High operational energy costs may be a concern. 
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7.46 Influent Sludge 
A sludge treatment and disposal system can be constructed in CapdetWorks independently from the 

liquid train. It is important to set the flow rate and the concentration of the sludge to be treated 

with a Sludge Influent process. Typical values for SS from various treatment processes are shown 

below: 

Expected Sludge Concentrations from various treatment processes 

Process Range(% Solids) Typical(%Solids) 

Primary Sludge 4-10 5 

Primary and Waste Activated 

Sludge 
3-8 4 

Primary and Trickling Filter 

Humus 
4-10 5 

Waste Activated Sludge 0.5-1.5 0.8 

Trickling Filter Humus 1-3 1.5 

Rotating Biological Contactor 

Waste Sludge 
1-5 3 

 

7.47 Digestion 
Sludge digestion primarily has a two-fold objective, stabilization of the sludge and reduction of 

sludge quantities. Stabilization produces a less odorous and putrescible sludge and also reduces the 

number of pathogenic organisms in the sludge. The reduction in quantity of sludge is desirable 

because it decreases the quantity and thus the cost of ultimate disposal of sludge. 

There are two popular methods of digestion currently used; aerobic and anaerobic, although other 

processes such as auto-thermal aerobic digestion and dual phase digestion are available. Aerobic 

digestion as its name suggests is carried out in an oxygen environment while anaerobic digestion is 

accomplished in an oxygen free environment. 

There are conventional and high-rate digesters; the conventional design uses the one or two stage 

process. In any of these systems, provisions are normally made for sludge heating. The principal 

difference in the one and two stage systems is that in the two-stage systems, digestion is 

accomplished in the first tank. 
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7.48 Aerobic Digestion 
This method of digestion is capable of handling waste activated, trickling filter, or primary sludge as 

well as mixtures of the same. The aerobic digester operates on the same principles as the activated 

sludge process. As food is depleted, the microbes enter the endogenous phase and the cell tissue is 

aerobically oxidized to CO2, H2O, NH3, NO2, and NO3. 

Up to 80 percent of the cell tissue may be oxidized in this manner; the remaining fraction contains inert 

and unbiodegradable materials. Factors to be considered during the design process are characteristics 

(origin(s)) of the sludge, hydraulic residence, true solids loading criteria, energy requirement for mixing, 

environmental conditions, and process operation. 

Advantages claimed for aerobic as compared with anaerobic digestion are: 

1. VSS is reduced to 40-50 percent, nearly equivalent to that for anaerobic 
2. Supernatant has lower BOD 
3. A relatively stable humus-like end product is produced 
4. More basic fertilizer values are recovered 
5. Operation is relatively simple 
6. Capital cost is lower 
7. Odor is minimal 

The major disadvantages are:  

1. A higher operating cost associated with O2 supply 
2. The lack of a useful by-product (no CH4) 

 

7.49 Anaerobic Digestion 
The advantages of anaerobic as compared with aerobic digestion include: 

1. Higher organic loading, i.e. rates of treatment not limited by O2 transfer. 
2. Minimal need for biological nutrients (N and P) and for further treatment. 
3. Lower energy requirement. 
4. Production of a useful by-product (CH4) which has a low heat value compared to 

natural gas. 
The disadvantages are as follows: 
 

1. Digesters must be heated to 85 to 90 deg F for optimum operation. 
2. Molecular oxygen is toxic to the system and must be excluded. 
3. Higher skilled operation is required. 
4. Anaerobic digesters are easily upset by unusual conditions and are slow to 

recover. 
5. Mixing in large tanks is more difficult. 
6. Gas codes must be complied with. 
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Recycled supernatant liquor tends to “shock” waste-water treatment facilities. 

The fact that a closed vessel is required complicates the inevitable cleaning necessary. 

The recovered gas, while useful, increases initial costs because of the necessity of providing 

explosion-proof equipment. 

Digested sludge tends to be high in alkalinity.  

 

7.50 Wet Oxidation 
Wet oxidation, also known as wet air oxidation, wet incineration, and wet combustion, is based on 

the principle that any substance capable of burning can be oxidized in the presence of liquid water 

at temperatures between 250 deg. F and 700 deg. F. In general, any degree of oxidation desired can 

be accomplished by providing the proper temperature, pressure, reaction time, and sufficient 

compressed air or oxygen. 

The process has been patented and is commercially known as the Zimpro process. The process is 

capable of operating satisfactorily at sludge solids concentrations as low as 1%, much less than that 

required for conventional combustion processes. 

The descriptions that follow are intended to be used to evaluate the wet air oxidation process as a 

disposal technique. It is not intended to give or lend the rights established by the patent held on the 

process described herein. 

The raw sludge is ground, reducing particle size to a maximum of 1/4 inch, and then mixed with a 

quantity of compressed air or oxygen. When the process is operated continuously, the air-waste 

mixture is pumped through a series of heat exchangers, thereby being brought to the initial reaction 

temperature, and then into the pressurized reactor. When the process is operated as a batch 

system, the heat exchangers are eliminated as a source of heating the reactor influent. 

The oxidation taking place in the reactor causes an increase in temperature. The oxidized effluent is 

cooled in the heat exchangers. Gases are separated from the liquid, which is carrying the residual 

oxidized material and released through a pressure-reducing valve into an odor-controlling, catalytic 

oxidation unit. These gases, when economical, may be expanded in a turbine as opposed to the 

pressure released to the atmosphere. Liquid and solids residue pass through a separate pressure-

reducing valve and the residue removed by conventional separation equipment. The solids are inert 

and may be disposed of accordingly. Wet air oxidation process wastewater must be returned to the 

beginning of the wastewater treatment facilities. The process can be designed to be thermally 

autogenous. When additional heat is needed, as in the cases of batch operation or process start-up, 

steam is injected into the reactor. This may also be necessary when low levels of oxidation are being 

used in process operation. 

There are certain disadvantages to using this system. After a period of from 30 to 60 days the heat 

exchangers must be isolated from the oxidized liquors, which are very high in organics, phosphorus, 
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and nitrogen, and reintroduced through the wastewater treatment system represents a 

considerable load and must be taken into consideration in over-all treatment plant design. The high 

pressure-high temperature system also introduces some safety problems which will play a role in 

the design of the plant facilities. 

Oxygen must be present in stoichiometric proportions to prevent impediment of combustion during 

the wet air oxidation process. Oxygen in excess of the required stoichiometric quantity will not 

accelerate the process. The chemical oxygen demand of the waste has been found to be a very 

convenient parameter of the oxygen required in the combustion process. Another parameter used 

and verified through experiments is the steam-to-air ratio. 

 

7.51 User Specified Sludge Process 
The user has control over all available parameters. 

 

7.52 Gravity Thickening 
Gravity thickening is a sedimentation process similar to that which occurs in all settling tanks. The 

process is the simplest of the available thickening processes. 

Gravity thickening may be classified as plain settling and mechanical thickening. Plain settling usually 

results in the formation of scum at the surface and stratification of sludge near the bottom. Sludge 

from secondary clarifiers usually cannot be concentrated by plain settling. Gentle agitation is usually 

employed to stir the sludge, thereby opening channels for water escape and promoting 

densification. A common mechanical thickener consists of a circular tank equipped with a slowly 

revolving sludge collector. Primary and secondary sludge are usually mixed prior to thickening. A 

ratio of secondary sludge to primary sludge of 8 to 1 or greater is recommended to assure aerobic 

conditions in the thickener. Chlorine has been used to prevent sludge septicity and gasification, 

which interferes with optimum solids concentration of organic materials. A chlorine residual of 0.5 

to 1.0 mg/L in the thickening tank overhead prevents such problems.  

Design of Thickeners  

In the design of thickeners, concentration of the underflow and clarification of the overflow must be 

achieved. Mechanical thickeners are designed on the basis of hydraulic surface loading and solid 

loading. These parameters are normally obtained from laboratory batch settling tests. Procedures 

for conducting the tests and evaluating the design parameters are documented in the literature. In 

the absence of laboratory data, the table below may be used as a guide for selecting solid loading 

rates. Typical surface loading rates of 600 to 800 gpd(US)/sqft are recommended for most 

thickeners. Hydraulic loading rates of less than 400 gpd(US)/sqft were reported to produce odor 

problems. Detention time of the thickener may range between 2 and 4 hours.  
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7.53 Belt Filtration 
Most of the comments related to filter presses are also applicable to belt pressure filters. 

In this design the sludge is spread across a woven synthetic fiber belt, which travels horizontally for 

a variable length where the action of both capillarity and gravity will allow a natural drainage. This 

belt, after running horizontally on supporting rollers, wraps around a rubber-covered drum provided 

with grooves for draining away the filtrate. The action of a continuous pressure belt of cloth 

reinforced rubber subjects a pressure by gradually decreasing the gap between the filter belt and 

the pressure belt as they move forward, so that the pressure applied increases over the whole 

length of the filtration zone. The dried cake is then removed from the filter belt by means of a 

flexible scraper. A second scraper is needed to clean the pressure belt. 

Chemical conditioning is required for belt pressure filters just as it is for filter presses. One notable 

exception is that, while filter presses usually require media conditioning, belt pressure filters do not 

generally require conditioning. Chemical addition, mixing, flocculation, and gravity thickening are 

required. In most instances polymer addition is helpful. 

There is a tendency for sludge to flow out the edges between the belts and to limit the applied 

pressure to slightly more than two atmospheres as pressure increases. Because of pressure 

limitation, the dryness of the cake does not approach that of filter presses. The following Table 

indicates typical operating performances of the “Flocpress.” 

 

7.54 Centrifugation 
Centrifugation is a widely used process for concentrating and dewatering sludge for final disposal. 

The process offers the following advantages: 

1. The unit is totally enclosed, thus odors are minimized 
2. The unit will fit in a small place 
3. The unit is flexible and can process a wide variety of solids 

 

Disadvantages associated with centrifugation are: 

1. Without the use of chemicals, solids capture is often poor 
2. Chemical costs can be substantial 
3. Maintenance costs are higher than some other filtration systems 
4. Fine solids (in concentrate) that escape the centrifuge may resist settling when 

recycled to the head of the treatment plant and gradually build up in 
concentration, eventually raising effluent solids level 

 

Centrifuges applicable to sludge thickening and dewatering fall into general classifications: disc, 

basket, and the solid-bowl or decanter types. Basically, centrifuges separate solids from liquids 

through sedimentation and centrifugal force. Process variables in centrifugation include feed rates, 
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sludge solids characteristics, feed consistency, and chemical additives. Machine variables include 

bowl design, bowl speed, pool volume, and conveyor speed. 

The main objectives in centrifuge design are cake dryness and solids recovery. The effect of the 

various parameters on these two factors are summarized in the table below. Operating data 

reported in the literature indicate that raw primary and digested primary sludge dewater easily. 

With polymer addition, a centrifuge can produce 25 to 40 percent cake solids with better than 90 

percent recovery. Waste activated sludge, however, is difficult to thicken or dewater with 

centrifugation. High polymer dosages will be required to produce 8 to 10 percent cake solids and 90 

percent recovery.  

One criterion used in determining the size of centrifuge required is the power requirement per 

gallon per minute of inflow (0.5 to 2.0 hp per gpm(US)). Generally, a power requirement of 

1.0hp/gpm(US) of inflow is applicable to most centrifuges commercially manufactured. 

 

7.55 Filter Press 
The filter press is a type of pressure filtration and differs from vacuum filtration in that the liquid is 

forced through the filter medium by a positive pressure instead of a vacuum. The press finds 

application primarily in the field of water and wastewater treatment as a means for dewatering of 

sludge. A number of different kinds of filter presses are currently available. Older models apply 

pressure by pumping the solution into chambers lined with filter cloth; whereas, the most recent 

designs actually press the water out by applying direct pressure to the sludge. 

 

Filter presses are available in varying sizes according to the amount of sludge to be dewatered. 

Optimum operation conditions are usually provided by conditioning, thickening, and other 

pretreatment to produce a sludge with an initial concentration of 3 to 5% and specific resistances of 

109 -- 1010 cm/g. 

The word press is somewhat misleading when applied to the earliest designs which originated in the 

early twentieth century. These early filter presses did not actually press the water out by 

consolidating the sludge, but instead the solution was pumped between plates that were covered 

with a fiber filter cloth where the liquid seeped through the filter cloth leaving the solids behind 

between the plates. When the void spaces became filled, the operator separated the plates to 

remove the solids.  

This type of filter pressing is a cyclic operation which has been the most objectionable characteristic 

of the process. However, this cyclic operation is considered to be an advantage in some cases. 

The unpopularity of the earlier filter presses has prompted new design approaches by several 

manufacturers toward continuous operating presses. Pretreatment of the sludge is required, 
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however, for either a batch or continuous flow operation. Usually a chemical addition (alum, lime, or 

ferric chloride) is followed by mixing, flocculation, and gravity thickening. Conditioning of the filter 

media may also prove to be beneficial. Extensive laboratory work is required to determine chemical 

requirements for plant optimization. 

Incineration and landfill costs may be reduced if filter presses are used because they produce a cake 

having 40 to 50% solids, while centrifugation and vacuum filtration produce only 20 to 25% cake 

solids (although some modern centrifuges are capable of higher cake solids). The filtrate from 

presses may contain as little as 75 mg/L suspended solids while the other two methods typically 

discharge 800 to 1000 mg/L suspended solids. 

 

7.56 Sludge Flotation Thickening 
The reader is referred to the Dissolved Air Flotation section of this Process Reference chapter for a 

complete description. 

 

7.57 Vacuum Filtration 
Vacuum filtration has been used methods mechanical dewatering of wastewater sludge; however, 

its popularity has decreased. The process is carried out using a slow rotating drum, the outside of 

which is covered by a filter medium. A portion (about 20 to 40 %) of the drum is submerged in 

sludge in the vat below the drum. Vacuum (10 to 26 in. of mercury) is applied to the submerged 

portion of the trough. As a result, water is drawn into the drum and a thin mat of sludge is formed 

on the filter medium. As the filter rotates, the vacuum is continued, and further moisture reduction 

occurs. In addition, the deposited cake is further dried by air which flowed through the cake into the 

drum. Before the filter cake reaches the sludge vat again, it passes over a roller and is broken off 

onto a conveyor for ultimate disposal. The time the drum spends submerged in the slurry is called 

the “filter time”; the time the cake spends on the drum above the vat is called the “drying time”. 

Vacuum filtration facilities are generally sold as a package by various filter manufacturers. In 

addition to the filter itself, the package normally includes vacuum pumps, sludge feed pumps, and 

belt conveyors that transport dewatered filter cake. Filter medium made of cloth (cotton, wood, 

nylon, dacron, or other synthetic material), coil springs, or a wire-mesh stainless steel fabric are 

available in various weaves of different porosities. 

Vacuum filter performance is measured by filtration rate and dryness of the filter cake. Several 

factors affecting the performance of a vacuum filter include: 

Vacuum - as the vacuum increases, the filtration rate and the dryness of the cake also increase; this 

process is limited, obviously, by capacity of the drum. An ideal filter design would incorporate two 

independent vacuum systems; one operating while the cake is being formed, and other after it 
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comes out of submergence and is being dried. A vacuum of at least 20 inches of mercury is 

desirable. 

Feed Solid Concentration - In general, the sludge filtration rates increase directly in proportion to 

the increase in feed sludge solids concentration; a smaller filtrate volume has to be removed per 

pound of filter cake formed. The practical limit for optimum operation for sewage sludge is 4 to 8 %. 

Drum Speed and Submergence - The drum speed influences the cycle time and consequently 

influences filter yield and filter cake moisture. A decrease in filter cycle time should increase the 

yield. However, lower filter cake moisture will be obtained by increasing the filter cycle, thereby 

extending the drying cycle. A submergence level of 20-40% has been used. It is usually more 

economical to run the filter at lower submergence since it will increase the ratio of dewatering time 

to cake formation time, and will still allow a short cycle for greater filtration rates. 

Chemical Conditioning of Sludge - Chemical conditioning of sludge is usually a necessary step prior 

to sludge vacuum filtration. Chemical conditioning agglomerates solids and causes a release of 

water, thereby making the sludge easier to filter. A wide variety of chemicals have been evaluated 

for conditioning sludge prior to vacuum filtration. In general, lime and ferric chloride are the most 

commonly used conditioners. Recently, some organic polyelectrolytes have become popular as 

sludge conditioners. The amount and type of conditioning chemicals required depend on the 

physical and chemical characteristics of the sludge. The tables below summarize chemical doses 

reported from the operating records of various treatment facilities. 

 

Vacuum filter systems are designed from data describing quantities of sludge to be filtered, sludge 

characteristics, filtration rates, cake moisture, and filter operation cycles. The data could be 

generated from laboratory or pilot investigations of the sludge. The Buchner funnel test and the 

filter leaf test are commonly used in laboratory testing programs for estimating the filterability of 

sludge. The Buchner funnel test evaluates the optimum chemical requirements and sludge filtration 

characteristics measured in terms of specific resistance. The filter leaf test determines the effect of 

different fabrics, fabric forms, and drying times on filter yield.  

Filter yield, or production rate, is the basic factor used in determining the size of vacuum filter 

installations. A conservative design rate of 3.5 lb/(sqft.h) has been widely used. However, assuming 

the yield to be equal to the solids concentration of the sludge to be filtered is more accurate. 

Generally, the yield may vary from 2 to 10 lb/(sqft.h). The low values represent filtration of fresh 

and digested activated sludge; the high values are typical for raw primary or primary plus trickling 

filter humus sludge filtration. 

Vacuum filtration was widely used for dewatering sewage sludge in small treatment facilities 

because of its flexibility, small space requirement, and the excellent characteristics of the cake. 
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Average Chemical Doses for Vacuum Filtrationa 

 Chemical Dose Rate (%) 

Type of Sludge Ferric Chloride Lime Polymer 

Raw primary 2.1 8.8 0.2-1.2 

Digested primary 3.8 12.1 0.2-1.5 

Elutriated digest primary 3.4 0.0  

Raw primary plus filter 

humus 
2.6 11.0 0.2-1.2 

Raw primary plus activated 2.6 10.1 0.5-2.0 

Raw activated 7.5 0.0  

Digested primary plus filter 

humus 
5.3 15.0  

Digested primary plus 

activated 
5.6 18.6  

Elutriated digested primary plus activated: 

Average without lime 8.4 0.0  

Average with lime 2.5 6.2  

 

7.58 Drying Beds 
Sludge drying beds are a common method for dewatering digested sludge, especially in small plants. 

Drying beds are usually constructed using 4 to 9 inches of sand over 8 to 18 inches of graded gravel. 

The beds are usually divided into at least three sections for operational purposes. An underdrain 

system usually of vitrified clay pipe, spaced 9 to 20 ft apart, is used to remove water. 

The design of sludge beds is influenced by many factors, such as weather conditions, sludge 

characteristics, land value, proximity of residences and use of sludge conditioning aids. 
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7.59 Sludge Drying Lagoon 
Lagoons have been used extensively in small systems for the dewatering of sludge. Drying lagoons 

are similar to sandbeds in that they are both designed for the dewatered sludge to be removed 

periodically and the lagoon refilled. However, they differ from sandbeds in that they use earthen 

levees and are built on the natural ground, therefore they are cheaper to build. 

Several factors must be considered in designing drying lagoons. The major factors include climate, 

subsoil permeability, lagoon depth, solids loading rates, and sludge characteristics. 

 

7.60 Hauling and Land Filling 
Land filling can provide an alternative for ultimate sludge disposal. The method may be of special 

importance if it can be integrated with solid waste disposal systems that have an operating sanitary 

landfill. Other methods of sludge treatment, such as drying beds or incineration, are considered to 

be methods of volume reduction that produce a residue requiring ultimate disposal. 

Sludge hauling and land filling may be approached in a manner similar to that for a typical solid 

waste disposal problem. Most solid waste disposal systems have at least four definable components: 

storage, collection, haul and disposal. In addition, sludge disposal systems usually require some form 

of pretreatment if associated costs are to be minimized. 

Pretreatment of sludge is related to reducing the volume to a minimum before transporting. Typical 

unit processes used for volume reduction may include digestion, and dewatering. 

Storage costs are site-specific and depend largely upon the method selected in the sludge handling 

train. They may be the costs associated with the purchase of tanks for storage of waste activated or 

primary sludge, a truck for storage of digested sludge solids that have been centrifuged or vacuum 

filtered, or the cost associated with sludge drying beds. 

Collection costs are dependent upon a time-labor relationship to transfer the sludge from storage to 

the transporting vehicle. There may not be a collection cost associated with labor; however, a cost 

would be incurred to provide a vehicle during the loading period. Larger facilities may require that a 

driver be assigned to the vehicle during loading periods. Collection costs may be significant when it 

is necessary to load sludge from drying beds into trucks for transportation to the landfill. As 

indicated in the above paragraphs, collection costs are site and system specific. 

Transportation costs are associated with such parameters as truck cost, truck size, haul time, labor, 

and operating costs per unit time for items such as depreciation, fuel, insurance, maintenance, etc. 

Operating costs may be estimated from manufacturer’s rating information and used in conjunction 

with estimates of sludge production from various wastewater treatment processes. 
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Disposal costs are related to the operation and management of the final disposal facility. This cost 

should be minimal if the facility will integrate ultimate sludge disposal with the disposal of refuse. 

When this is possible, the disposal costs may only include the costs of unloading and a landfill fee. 

On the other hand, if the landfill is to receive only waste sludge; costs may be significant as other 

equipment for operation of the landfill will be required. The equipment used for landfill operation 

may include units for excavation, placing, covering, and compaction of fill. 

The lowest possible moisture content attainable at a reasonable cost should be produced for 

economical sludge hauling and landfill operations. A reduction of moisture content will produce a 

savings in storage, initial equipment, operating, and labor costs. 

 

7.61 Fluidized Bed Incineration 
High temperature processes have been used for combustion of municipal wastewater solids since 

the early 1900’s. Popularity of these processes has fluctuated greatly since their adaptation from the 

industrial combustion field. In the past, combustion of wastewater solids was both practical and 

inexpensive. Solids were easily dewatered and the fuel required for combustion was cheap and 

plentiful. In addition, air emission standards were virtually non-existent. 

In today’s environment, wastewater solids are more complex and include sludge from secondary 

and advanced waste treatment processes. These sludge are more difficult to dewater and thereby 

increase fuel requirements for combustion. Due to environmental concerns with air quality and 

energy costs, the use of high temperature processes for combustion of municipal solids is being 

scrutinized. 

However, developments in more efficient solids dewatering processes and advances in combustion 

technology have retained the interest in the use of high temperature processes for specific 

applications. High temperature processes should be considered where available land is scarce, 

stringent requirements for land disposal exist, destruction of toxic materials is required, or the 

potential exists for recovery of energy, either with wastewater solids alone or combined with 

municipal refuse. 

High temperature processes have several potential advantages over other methods: 

Maximum volume reduction. Reduces the volume and weight of wet sludge cake by approximately 

95 percent, thereby reducing disposal requirements. 

Detoxification. Destroys or reduces toxics that may otherwise create adverse environmental 

impacts. 

Energy recovery. Potentially recovers energy through the combustion of waste products, thereby 

reducing the overall expenditure of energy. 

Disadvantages of high temperature processes include: 
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Cost. Both capital and operation and maintenance costs, including costs for supplemental fuel, are 

generally higher than for other disposal alternatives. 

Operating problems. High temperature operations create high maintenance requirements and can 

reduce equipment reliability. 

Staffing. Skilled and experienced operators are required for high temperature processes.  

Environmental impacts. Discharges to atmosphere (particulates and other toxic or noxious 

emissions), surface waters (scrubbing water), and land (furnace residues) may require extensive 

treatment to assure protection of the environment. 

Multiple-hearth and fluid bed furnaces are the most commonly used sludge combustion equipment 

in the United States and Europe. These two processes are considered in this section. 

Fluidized bed incineration for wastewater sludge involves the destruction of wastewater solids 

through combustion. Basically, dewatered sludge is pumped into the incineration vessel containing a 

heated catalytic bed. This bed is fluidized by a controlled upward airflow at pressures of 2.0 to 5.0 

psig; this air also supplies oxygen for combustion. Temperatures for combustion range from 1200 to 

1600 deg F. Supplemental fuel may be added by burners to keep temperatures at optimum levels if 

the sludge characteristics do not allow for autogenous combustion. Burning of wastewater sludge 

produces ash and several gases which are carried upward by the flow of air through an exhaust 

stack. Normally, some type of air pollution equipment such as scrubbers, electrostatic precipitators, 

and cyclones are connected to the process to remove the incinerator byproducts. This exhaust may 

also pass through other control devices if noxious odors are expected to result from combustion. 

The fluidized bed incinerator used for combustion of wastewater sludge is a vertical cylinder with an 

air distributor plate containing small openings near the bottom. The base plant serves two 

functions; 

1. allows air to pass into the media and  
2. supports the media.  

 

An external air source forces the air into the bottom of the vessel where it is distributed in a manner 

to fluidize the bed and supply oxygen for combustion. 

The bed material is composed of graded silica sand with size varying from ASTM No. 8 to No. 20. The 

normal operating temperatures for these fluidized sand beds are between 1200 and 1600 deg F. At 

this temperature, the sand approaches its melting point which is detrimental to the incinerator 

process. Also, damage to the incinerator vessel would be experienced in the heat exchanger and fuel 

piping. 
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There are two possible locations for the sludge feed inlet to be placed on a fluidized bed incinerator 

vessel. One is positioned so that the sludge is pumped (screw-type) directly into the fluidized bed. 

The advantage of this configuration lies in the fact that complete combustion is realized in a short 

time. Yet, problems can be incurred due to clogging from dried sludge. The second location is above 

the fluidized bed or the freeboard zone. Hot gases evaporate the water in the sludge as the solids 

enter the vessel. This operation is more amenable to combustion of solids with high moisture 

contents. However, combustion time for the elevated configuration is increased. 

Sludge combustion in an incinerator occurs in two zones; Zone 1 (bed) where the principal processes 

are pyrolysis and combustion and Zone 2 (freeboard) where the principal processes are flame 

holding and final burnup. Combustible elements contained in sludge are carbon, hydrogen, nitrogen, 

and sulfur, which when completely burned with oxygen, form the combustion products CO2, H2O, 

NOx, and SO2, respectively. Ash is also generated in the process of incinerating sludge. The NOx, SO2, 

and particulate ash can be classified as major air pollutants. In order to prevent the release of these 

by-products into the atmosphere, all fluidized bed incinerators are equipped with scrubbers of 

varying efficiency. These units have been found to be effective. 

In some cases, an air preheater or heat exchanger can be used in conjunction with a fluidized bed. 

The function of the preheater is to raise the temperature of the incoming air to 1000 deg F by mixing 

the cool air with the exhaust gas at 1500 deg F. 

It should be noted that fluidized bed incinerators are very specialized equipment and are not usually 

designed by general consultants and not installed by the general contractor for the sewage 

treatment facility. The incinerator is usually obtained on a turnkey basis from the manufacturer; that 

is, the manufacturer designs and installs the equipment required for incineration of the sludge. The 

only work done by the general contractor would be construction of the foundation and building to 

house the incinerator.  

Much of the information concerning sizing and design of fluidized bed incinerators is proprietary as 

it has been developed by the manufacturers. It is difficult to relate any one design parameter to the 

cost, because of the difference in design from manufacturer to manufacturer. We have chosen to 

use the diameter of the unit to relate to the cost in CapdetWorks. 

 

7.62 Multiple Hearth Incineration 
The multiple-hearth furnace is the most widely used wastewater sludge incinerator in use today 

because it is simple to operate, durable and capable of burning a wide variety of materials. 

Reasonable fluctuations in the feed rate may be accommodated without interruption of the 

incineration process. Sludge from water or wastewater treatment is normally thickened and 

dewatered by vacuum filtration and/or centrifugation. The dewatered sludge enters the multiple-

hearth furnace at the top and is held first on the top hearth. The sludge is stirred constantly to 

promote drying and burning by rabble arms. These slow-moving arms move the sludge across the 



CapdetWorks V4.0  2018 

 

7-149 | Hydromantis Environmental Software Solutions, Inc. 

 

hearths to the inner or outer edge where it drops to the hearth beneath. This process continues 

until the sludge reaches the bottom of the furnace as ash. 

The multiple-hearth incinerator, like the fluidized bed incinerator, is a special item of equipment. It 

is generally provided by the manufacturer on a turnkey basis. All necessary equipment, installation, 

and start-up are provided by the manufacturer. The general contractor provides the concrete 

foundation and a building, if required.  

 

7.63 Pressure Swing Adsorption (PSA) 
PSA is a well-established gas separation and purification technique that is utilized in applications 

such as air separation, gas drying, hydrogen purification and methane purification. PSA units use the 

adsorptive capacity of zeolites (molecular sieves) to effect a preferential removal of gases within a 

mixture. A stream of the contaminated gas is passed through a bed containing the zeolite material 

under pressure. Zeolites are hydrated aluminosilicates, and are typically supplied as small size 

spherical beads (1-2 mm). In its simplest form, a PSA system comprises of two beds, which are 

alternately pressurized and depressurized. The depressurization step regenerates the zeolite. 

Generally, Zeolites are selected to be preferentially adsorptive to one or more of the gases, such 

that as the gas stream passes through, a “clean” stream of the non-adsorbed gas is generated. 

Commonly used zeolites tend to be proprietary materials. However, a reasonable amount of 

information is available on a variety of them. For a given target removal efficiency for each 

contaminant, specified by the user, the PSA design allows for the determination of the equipment 

size, zeolite quantity, system pressure, power requirement, reactor temperature, cycle run times 

required to meet specific biogas cleaning and upgrade targets and compressor power. The 

equipment specification is then used to calculate the operating and capital costs.  The system allows 

for the customization of media properties (e.g., bulk density, diameter and adsorption isotherms), 

bed characteristics, and unit costs (e.g., $/Ib adsorbent, $/ft2 vessel) 

 

7.64 Moisture Removal 
Biogas is usually saturated with moisture. Estimates for the water content of biogas range from 

about 4 to 8% of the biogas by volume which comes to about 30 to 100 g water per m3 gas. Moisture 

removal from biogas can be carried out using a variety of options and approaches. The mostly 

commonly utilized methods involve (i) the cooling and dehumidification of biogas using heat 

exchangers, or (ii) absorption using materials such as silica gel and Al2O3, glycol and hygroscopic salts 

and/or molecular sieves. The design approach utilized involves either the specification of a target 

moisture content for the biogas, or a target temperature. Moisture values are set at a default value 

of about 50,000 ppm in the raw biogas, while the default target temperature for the outlet from the 

moisture removal system is set a 5oC (41oF). These can be varied. Additional design variables that 

can be adjusted by the user includes the Coefficient of Performance (COP) for the system. Design 
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information obtained include dew point, heat flux, chiller power (HP), water loss rate as well as 

chiller and construction costs.  

 

7.65 Iron Sponge Treatment 
Iron sponge use for hydrogen sulfide removal has been applied commercially for an extended period 

of time. It consists of reducing iron oxide (Fe2O3) with H2S to form Fe2S3. The formula for the reaction 

is given as: 

Fe2O3 + 3H2S → Fe2S3 + 3H2O            

Depleted Iron sponge can be revivified (recovered) using air treatment (Johnson et al, 1962).  

As can be seen from equation 1, water is a byproduct of the reaction and must be periodically 

drained from the bed to prevent flooding.  

2Fe2S3 + 3O2 → 2Fe2O3 + 6S           

The elemental sulfur formed in the revivification process remains on the surface of the iron leading 

to a gradual reduction in the effectiveness of the bed. Removal rates of H2S based on Iron sponge 

treatment can be as high as 2,500 mg H2S/g Fe2O3. 

The user specifies parameters such as the bed height, superficial gas velocity, reactor contact time, 

media properties (e.g., bulk density, iron sponge grade, number of cycles, regeneration time, 

regeneration efficiency) and cost metrics ($/Ib of Iron sponge, $/ft2 of vessel). Design output 

includes reactor size (volume, diameter), mass of media required, media replacement period, 

number of reactors needed, and compressor / blower power.  

 

7.66 Unit Costs 
The accuracy of any cost estimate depends not only on the correct determination of sizes and 

quantities of material, equipment and labor to be used on the project, but also on the unit price 

inputs used. The cost estimating technique used by the CapdetWorks requires input of current unit 

prices if model accuracy is to be maintained. Default unit price data is available and will be used in 

the calculation process if not overridden by the user.  

 

7.67 Additional Site-Specific Costs 
The unit price cost estimating technique is applied to the calculation of costs associated with the 

construction of unit processes. In order to calculate total wastewater treatment facility construction 

costs, other cost components must be included. These cost components, denoted as “Additional 

Site-Specific Costs”, are the components necessary to connect unit processes into a functioning 

treatment facility. 
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7.68 Cost Indices 
To account for changing costs over time in the costing algorithms, CapdetWorks uses a number of 

equipment-related cost indices to adjust costs to the present. The indices used are: 

MAS - Marshall and Swift Equipment Index (Chemical Engineering) 

PIPE - Pipe, Valve and Fitting Cost Index (Chemical Engineering) 

ENR - Engineering News Record 20-City Construction Cost Index 

HECI- Hydromantis Equipment Cost Index 

HCCI- Hydromantis Construction Cost Index 

HPCI- Hydromantis Pipe Cost Index 

 

The Hydromantis Cost Indices are has a base value of 100 for the year 2014. The updated values of 

the index are estimated based on the standard cost indices like MAS, PIPE, ENR and CPI and are 

available for update from within CapdetWorks.  


